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Tutorial 1: Set up the Environment Appeon® PowerServer® 2020

1 Tutorial 1: Set up the Environment

Y ou will need to go through the following tasks to set up the PowerServer 2020 environment
for deploying and running the mobile application:

1.1 Task 1: Prepare the machine

The simplest scenario will be used in this guide, which requires 1 Windows PC and 1
Android device.

* 1 Windows PC: used as the development machine and the server

* 1 Android or iOSdevice: in thistutoria, an Android device is used as the mobile client

The 32-bit version of Power Server Mobilefor .NET edition will be used to walk
you through this guide, so please prepare the environment according to the following
reguirements.

Software requirements for Windows PC:

* Windows 10 (32-bit or 64-bit)

Power Server M obile 32-bit version can be installed to the 64-bit OS without any special
considerations. But if you have installed Appeon Power Server 64-bit version before
please uninstall it first. See Task 1.2: Uninstall previous version of 64-bit PowerServer.

* Internet Explorer 11

* (Optional) SAP SQL Anywhere (32-bit engine) 11.0, 12.0, 16.0, or 17 (for running the
demos included with the PowerServer installation)

* NET Framework 4.x

e |[IS10
SeeTask 1.3: Install 1S and Task 1.4: ConfigurellS.

» PowerBuilder 2019 R2 & PowerServer Mobile 2020

It is recommended that you install Power Builder 2019 R2 CloudPro Edition. The
universal edition includes the installation of PowerBuilder IDE, PowerServer (PB Edition),
and PowerServer Toolkit.

See Task 2: Install PowerBuilder and PowerServer for installation instructions.

Software requirements for the Android device:
» Google Android 6.x (32-hit), 7.x, 8.x, 9.x, or 10.x

» Appeon Workspace
See Task 3: Install Appeon Workspace (on the Android device)
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1.1.1 Task 1.1: Disable UAC (User Account Control)

On the Windows PC, go to the Control Panel > User Accounts and disable UAC by setting
the dider to "Never notify" (see screenshot below). After you have disabled UAC you
MUST restart the computer. If you do not restart the computer the change will NOT take
effect.

Figure 1.1: Disable UAC

-

'f‘:;' User Account Control Settings - =RECE X
Choose when to be notified about changes to your computer
User Account Control helps prevent potentially harmful programs from making changes to your computer,
Tell me more about User Account Control settings
Always notify
- - Never notify me when:
®  Programs try to install software or make changes to
my computer
- - ®  Imake changes te Windows settings
- - N
IZ&] Mot recommended. Choose this only if you need to [
use programs that are not certified for Windows 7
- - because they do not support User Account Control.
MNever notify
[ Pyl OK l [ Cancel

1.1.2 Task 1.2: Uninstall previous version of 64-bit PowerServer

If you are using a 64-bit machine you can install Power Server Mobile (32-bit) to the 64-
bit OS without any specia configurations. But if you have a previous version of Appeon
Power Server (64-bit) already installed on this machine then you must uninstall it first.

Step 1: Open |1S Manager, right click the top node (not the website node) in the treeview
and select Stop from the popup menu. Thiswill stop the entire 11S.
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Figure 1.2: Stop theentire IS Manager

‘aﬁ Internet Information Services (II5) Manager EI@
{:JU [ €5 » HXaA-PC » | & < @
File  View Help
Connections _ Actions
GJ' HXXIA-PC
=k Manage Server
h_.EI HH A - P temsim AU el HDmE *  Rectart
i3 Refresh ‘
@ Add Web Site... o | B Stop
Start @ [ View Application Pools
|. Stop | ~ View Sites
MET T
Rename L. Compilation
{2 Switch to Content View “ ® Hep
T =T Online Help
MET Error MET
Pages Globalization
- ..
P [E
WFT Trust Annlicatinn
]
Ready L=

Step 2: Close any opened window, especially Power Builder and I1S Manager .

Step 3: Uninstall all of the PowerServer components including Power Ser ver, Power Ser ver
Toolkit, and Power Server Help. You will need to uninstall these components one by one.

Step 4: Verify PowerServer is cleanly uninstalled by the following two steps:

» Double check the Control Panel\Programs\Programs and Featur es and make sure no
PowerServer component is listed.

* Open acommand prompt window and then type r egedit<Enter>. Double check that no
ADT or ASN keys are listed under HKEY _LOCAL_MACHINE\SOFTWARE\A ppeon

\<version_number>.
Step 5: Clear the Internet Explorer cache and temporary files.
Step 6: Delete the entire Appeon folder from C:\Users\User_Name\A ppData\Roaming\.

Step 7: Delete all the PowerServer application folders from the 11S Web root. For example,
under C:\inetpub\wwwroot\ at minimum you should delete the following folders. appeon,
appeon_acf _demo, appeon_code _examples, pet_world, sales application_demo.

Step 8: Restart the machine.

Step 9: Start 11S by right-clicking the top node in the treeview in the 11S Manager and
selecting Start from the popup menu.
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After that, you can proceed to install Power Server M obile by following stepsin Task 2:
Install PowerBuilder & PowerServer.

1.1.3 Task 1.3: Install IS
I1Sisnot installed on Windows 10 by default. Y ou need to manually install it.

Beforeyou install 11S, make sure you have installed .NET Framework 4.x. To install .NET
Framework 4.x for Windows 10, please go to the Turn Windows features on or off and
check the box for ASP.NET 4.7.

Below are steps for installing 11S. If you already have 11S installed, please carefully verify
the correct 11S options are checked (see screenshots below). By default, not all the required
components will be installed.

Step 1: Click Start and then click Control Panel. In Control Panel, click Programs and then
click Turn on or off Windows features.

Step 2: Select the check box of Internet Information Services, then expand the list and
select the items under Web M anagement Tools, Application Development Features and
Common HTTP Features according to the figure below. Click OK to let Windows finish
the install.

Figure 1.3: Select the Web Management Tools

- a1

ﬁ? Windows Features | = || (=] ||£3|

Turn Windows features on or off L7

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature 15 turned on.

] | Indexing Service -
. Internet Explorer 9
= . Internet Information Services

@[] FTP Server
= i Web Management Tools

. 56 Management Compatibility
, IS Management Conscle
, IS Management Scripts and Tools
, IS5 Management Service
| World Wide Web Services
7] I Internet Information Services Hostable Web Core
@ [¥] L Media Features -

m

QK | | Cancel
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Figure 1.4: Select the Application Development Features

[~} Windows Features || B[]
Turn Windows features on or off (7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature 15 turned on.

= . Internet Information Services -~
] b, FTP Server |
. Web Management Tools ‘

m

= . Waorld Wide Web Services

= " Application Development Features
. NET Extensibility
| ASP
. ASP.NET
ED
, ISAPI Bxtensions
, ISAPI Filters
1L Server-Side Includes b

l QK J | Cancel
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Figure 1.5: Select the Common HTTP Features

" a1

[~} Windows Features = | B[]

Turn Windows features on or off e

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

= . Internet Information Services -
] b, FTP Server
. Web Management Tools
= [H |, World Wide Web Services

| Application Development Features

= il Common HT TP Features

m

, Default Document

. Directory Browsing

; HTTP Errors

] I, HTTP Redirecticn

, Static Content

1L WebDAY Publishing -
OK | | Cancel

Step 3: After l1Sisinstalled, go to I1S Manager, right click the Default Web Site, select
Binding, and make sure | P Addressisindicated with an asterisk "*". If not, please click Edit
and select All Unassigned for the | P address, thiswill display | P Address as an asterisk "*".

Step 4: Run http://IP_Address:80/ in Internet Explorer. If the [1S welcome screen displays,
then 11Sisworking properly.

Tip: to obtain the I P address of the server, open a command prompt window and then type
ipconfig<Enter>. Remember this IP address as it is also needed when you configure the
mobile app in Appeon Workspace.

If 1Sisnot working, please re-install 11S or fix the I1S configuration by following the IIS
help.

1.1.4 Task 1.4: Configure lIS
Follow steps below to grant 1S USRS account with full controlsto the 11S Web root folder:

Step 1: Right click the C:\Inetpub\wwwr oot folder and select Properties from the popup
menul.

Step 2: On the Security tab, select 1S USRS in the Group or user names list box, and
then click the Edit button.
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Figure 1.6: Select IIS_IUSRS

-

i - wwwroot Properties

General | Sharing | Secunty | Previous Versions | Customize

Object name:  C:inetpub’wwwwroot

Group or user names:

52 Users {rooda-PCUsers) -
F11S_IUSRS {reoda-PCAIS_IUSRS)

52 Trustedinstaller

* [

4 | 1l [ »

To change pemissions, click Edit. |

B

Pemissions for 115_|LUSRS Allow Dermy

Full control

Modify

Read & execute
List folder contents
Read

Write v

| »

m

AR NN

For special pemissions or advanced settings, Advanced
click Advanced. | Lt

Leam about access control and pemissions

OK || Cancel | 2pph

Step 3: Select 11S_IUSRS in the Group or user names list box, and then select the Allow
check box for the Full control.
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Figure 1.7: Select Full control for [IS_ITUSRS

" a1

. Permissions for wwwroot @

Security

Object name:  C:hinetpub’wwwwroot

(@roup or user names:

Q?JCHEATDH OWMNER

*3?__ SYSTEM

‘3{ Administrators (reeda-PC\Administrators)
‘3{ Users {rooda-PC\Users)

52 1IS_IUSRS (recda-PCHIS_IUSRS)

;ﬁJ Trustedinstaller

| Add | | Bemove
Pemissions for 115_|LUSRS Allow Demy
Full control [ i
Modify = |
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List folder contents |
Read [ i

Leam about access control and permissions

OK || Cancel || Apply

Step 4: Click OK to save the settings.
1.2 Task 2: Install PowerBuilder and PowerServer

1.2.1 Task 2.1: Install PowerBuilder and PowerServer

Step 1: Start 11S server: open 11S Manager, right click the top node (not the website node) in
the treeview and select Start from the popup menu.

Step 2: Log into the Appeon User Center, and download the PowerBuilder Installer
executable from the Downloads page on the Appeon User Center.

The PowerBuilder Installer executable (Power Builder I nstaller _bootstrapper.exe) is
available in your download directory after it is downloaded.

Step 3: Double click Power BuilderInstaller_bootstrapper .exe to start the PowerBuilder
Installer (you must have administrator privileges to run the installer).
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Step 4: Select to agree to the license terms and click Continue.
Step 5: Click Install under PowerBuilder 2019 R2 and select CloudPro Edition.

Step 6: From the Available list on the Productstab, select Power Builder 1DE,
Power Server (PB Edition), and Power Server Toolkit.

Step 7: Click Install to begin the installation.
Step 8: When the installations are completed, click Restart now to reboot the system.

1.2.2 Task 2.2: Verify the installation

On the Windows PC, run http:/IP_Address.80/AEM/. If AEM islaunched successfully, then
PowerServer isinstalled successfully.

1.3 Task 3: Install Appeon Workspace (on the Android device)
Instructions for Android:

Step 1: Enable the Unknown resour ces option (in Settings > Security) on the Android
device so you can install apps that are not downloaded from Google Play.

Step 2: Make sure your Android device can connect to PowerServer.

Step 3: Visit the Appeon Workspace download center that is posted on PowerServer
(http://Server _IP:80/AWS), and then click the download button.

1.4 Task 4: Configure the network connection

Check and make sure the Windows PC and the mobile device connected to the same

Wi-Fi router. To verify this, on the mobile device, open the Web browser and type
http://Server_1P:80/AEM/. If AEM is launched successfully, it means that the PowerServer is
properly installed and that the mobile device is able to connect to the Windows PC.

NOTE: Mobile Internet is supported by PowerServer Mobile. However, in order for

the Appeon Workspace to connect to your PowerServer you will need an external |P
address. Y ou can verify that your external |P addressis properly working by typing http://
External_IP_Address: 80 into a Web browser of any device connected to the Internet. If you
get a page not found error or other HTTP error then your network is not configured properly
for external access.
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2 Tutorial 2: Config, Deploy & Run the
Application

Thistutorial will use the PowerServer Mobile for .NET edition to walk you through
configuring, deploying and running the mobile application.

2.1 Task 1: Configure the database type

.__l
Step 1: On the PowerServer Toolkit, click the Configureicon (}\).
Step 2: On the Power Server Toolkit Configuration window, click the DB Type Profile tab.

Step 3: View the Configured column of the database type used by your application, if it
displays Y es, you can skip the remaining stepsin thistask. Otherwise, select the database
type used by your application, and then click Configure.

Figure2.1: DB TypeProfilein ADT

2%, PowerSever ToolKit Configuration @

| Application F'ru:ufiles| DE Type Profiles | Server Profiles I Deployment Profiles | Data Source Profiles

[Databaze Type Configuration

The Databaze Tepe profile tell: &ppeon for PowerBuilder which database type iz uzed to convert PowerBuilder SEL
statementz. Configure the profiles below, then azsociate profiles with individual application in the Application Profiles |

DB Settings tab.
Supported Database Types Configured -
Oracle 9i Mo
Other Mo
PostgreSEL Mo
SAP ASE Mo
SAP HAMNA, Mo
SAP 1O Mo E
SAP SA | Ultralite Y
SOLite
Teradata Mo i

[ Ok ][ Cancel ]

Step 4: On the Database Type Profile Configuration window, do the following (take SAP
SA | UltraLl ite as an example):

1. Select the ODBC I nterface radio button from the Database I nter face option.

2. Select a data source from the Data Sour ce dropdown list box. It can be any data source
(ODBC DSN) provided it is the same type as used by your application. It does NOT have to
be the actual ODBC DSN used by your particular application. The database typeiswhat is
important and that a connection can be established to the specified ODBC DSN.
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3. Keep therest as default, and then click Test Connection.
4. Make sure that the database connection is successful.
5. Click OK.

Figure 2.2: Database Type Profile Configuration

K Database Type Profile Configuration @

For each databaze wpe used in your application(s), you must provide an ODBC or Mative Interface connection to a
database of that type in order for PowerServer Toolkit to connect to the data source during deployment.

You need only provide one connection to each tepe of database used in your application.

Databaze Settings

Databaze Type: SAP 54 | Ultralite
Database Interface: ) DDﬁﬂlnterfacE M ative Interface
Cyntax: | Encloze table and calumn names in quotes
Outer Jain Syntaw: |.-'1'-.NSI - |

ODBC Interface Mative Interface
Data Source: |.ﬁ.ppEDnSample - |
Uzer 1D:
Pazgword;

ODBC Admiristratar. .

| Test Connection | [ ] 4 ]l Cancel |

Now the Configured column of your database type will be indicated by Yes. You can select
the database type when you create the application profile for your application in Task 3:
Configure and deploy the application.

2.2 Task 2: Configure the database connection

Database connection for a mobile application

Unlike the PowerBuilder client/server application which accesses the database server
via transaction objects, the mobile (and Web) application accesses the database server
via data sources which are created separately in the application server. For more
information about the database connection, refer to Chapter 3, Database Connection
Setup in Power Server Configuration Guide for .NET.

Step 1: In the Power Server Toolkit Configuration window, click the Data Sour ce Profile
tab.

Step 2: Select L ocal Power Server from the Power Server dropdown list box.
Step 3: Click the Add button to create a data source in the selected PowerServer.
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Figure 2.3: Connection Cache Profiles

-

2%, PowerSever ToolKit Configuration @

| Application Profiles I DB Type Profiles I Server Profiles I Deployment Profiles | Data Source Profiles

Data Source

Configure the data zource anly if pour PowerServer iz installed on 115, Data sources in the zelected PowerServers will
be automatically displaved.

PowerServer: Local PowerServer - ]

Marme DB Host Edit...

appeonzample AppeonS ampleFors erver
appeonzample? AppeonSample2Fors erer

IJ} |:
[l
[N

Delete

[ OF. J[ Cancel ]

Step 4: On the Add Data Sour ce window, specify the data source settings. Below we take
SAP SQL Anywhere and Microsoft SQL Server database as examples.

Steps for configuring a data source for SAP SQL Anywher e database:

1. In the Name text box, input any text you like as the name of the data source.
2. Select ODBC Driver from the Driver dropdown listbox.

3. Select the data source from the ODBC Data Sour ce dropdown listbox.

4. Input the database login user name and password respectively in the User Name text box
and the Passwor d text box.

5. Keep therest as default, and then click Test. Make sure the test is successful.
6. Click OK.
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Figure 2.4: SAP SQL Anywhere data source

EK Add Data Source @ﬂ
Narne: sa_db
Databaze
Diriver. ODBLC Driver i
Hoat:
Part:
ODBC Data Source: &ppeonSample i
Ueer Mame: dba
Pazzword: e
Character Set: ASCI
Session Mode: DEFALILT
Maxirmurn Connection Pool Size: 100
Minirurn Connection Pool Size: 10
Connection Timeout [zeconds]: 120
Command Timeout (zeconds]: a0
Connection Lifetime [seconds]: 0
Cther Dptions:
Dynamic D atabaze Connection + | Poaling
| ak. | | Caticel |

Steps for configuring a data source for Microsoft SQL Server database:

1. In the Name text box, input any text you like as the name of the data source.
2. Select MS SQL Server Native Driver from the Driver dropdown listbox.

3. Input the IP address or machine name of the database server in the Host field.
4. Input the port number of the database server in the Port field.

5. Input the database name, database login user name and password respectively in the
Database Name, the User Name and the Passwor d text boxes.

6. Keep the rest as default, and then click Test. Make sure the test is successful.
7. Click OK.

Tip: you should check with your SQL Server administrator to verify the port number, the
user name, and the password are correct.
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Figure2.5: MS SQL Server data source

K Add Data Source @
M arme: narthisind
Databaze
Diriver: M5 SOL Server Mative Driver N
Host: 192.0.0.205
Fart: 1433
Databaze M ame; hiarthusind
Uzer Name: 23
Pazzword:
Character Set: ASCI
Seszion Mode: DEFALLT
HMawimum Connection Pool Size: 100
Minirmurn Connection Pool Size: 10
Connection Timeout [zeconds]: 120
Command Timeout [zeconds]: a0
Connection Lifetime [seconds): 0
Other Optionz:
Dynamic Database Connection | Pooling
| ak. | | Cancel |

Now the data source you added will be listed in the Data Sour ce Pr ofiles tab. Y ou can select
it when you create the application profile for your application in Task 3. Configure and
deploy the application.

2.3 Task 3: Configure and deploy the application

Step 1: On the PowerServer Toolkit click the first icon Config Wizard ( |_:Iﬂ)
Step 2: In the welcome screen click Next.
Step 3: Specify following settings and then click Next.

1. Specify the application profile name in the Application Profile Name text box. The same
text will be displayed in the Web Folder text box and the M obile App Name text box. You
can modify these fields to use different text.
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2. Select M obile from the Project Type dropdown list box.
3. Select a device type from the Device Type dropdown list box.

For applications that are designed for tablets, select Tablet; for applications that are designed
for smartphones, select Smartphone; for applications that are designed for both devices,
select Both.

4. In the M obile App I con text box, specify an icon for your application by clicking Browse
to select the image file of the PNG or JPG format. The image that you choose will be
displayed as the application icon in the Appeon Workspace. Recommended size is 86 X

86 pixels (or above) for low-resolution display and 172 x 172 pixels (or above) for high-
resolution display (such asretina display). To ensure the best display quality in both high-
resolution and low-resolution screens, you must supply an image of 172 x 172 or above. The
image will be automatically shrunk to fit properly. If you leave this field empty, the default
icon will be displayed in Appeon Workspace.

5. Enter abrief description in the Mobile App Description text box. This description will
be displayed in the Appeon Workspace next to the application icon. If you leave thisfield
empty, no app description will be displayed in the Appeon Workspace.

6. Select a background color for the app if necessary.

Figure 2.6: Power Server Toolkit Configuration Wizard

|_-:|¢ PowerServer Toolkit Configuration Wizard @

Please configure the following options:
Welcome

Application Profile Mame:  sales_app

Configure basic settings ‘Wb Falder: sales_app

B Select PBL files ,

Project Type: [Mu:ul:uile S ]
B Configure deployment settin

Device Tupe: [Smartphnne V]
B Select DB types

. ) |

W Declare transaction object(s) ‘ et (=S Falme-ar

Mabile App lcon: C:\U zerghPublichDocumentshdppeonh T
B Select image files Mabile App Description: & sales app for mobile device. -

B Select IMI files

B Deploy Bxternal Files

[7] Uze this background color for the mobile app:

B Summary

[ < Back ][ Mest = ][ Cancel ] Finizh

Step 4: Add the PBT from the PBT dropdown list box (and all related PBLs will be
automatically added for you) or add the PBL filesindividually that are used in your
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application by clicking the Add File button in the PBL File List group box, and then select a
PBL version from the PBL Version dropdown list box. Click Next.

Figure2.7: Add the PBT in ADT Wizard

|_-:|¢ PowerServer Toolkit Configuration Wizard @

Select the PBL files used in your application:
Welcome

Configure basic settings PBT: I\ serstPublich Documents Appeon T oolkitvappeon: E]

Solact PRI files Keep PET Updated

B Configure deployment settings

PELVersion. | PowerBuilder 2019 -
W Select DB types

FEL File List:

c:huzershpublichdocument i appeonhtoolkithappeondemaohzalesmobiledemos.
c:huzershpublichdocument s appeonitoolkithappeondemohzalezmobiledemats
c:wuzershpublichdocumentshappeonitoolkitsappeondemotzalesmobiledemots. | =

W Declare transaction object(s)

*

1

B Select image files c:huzerspublichdocumentshappeontoalkitappeondemohsalesmobiledermats. T

e o huzershpublichdocument s\ appeonhtoolkithappeondemaohealesmobiledemate

B Select INI files chwgershpublichdocumentshappeonttoolkityappeondemotzalesmobiledemote
B Deploy External Files 4| mn | b
Add... Remove

N Summary

< Back ][ Mest = ][ Cancel Finigh

Step 5: Keep the default settings and click Next.

Since you have installed PowerServer Toolkit and PowerServer on the same machine, you
can directly use the L ocal Power Server profile, the L ocal Web Server profile, and the

L ocal Deployment profile, all of which are configured automatically by the product setup
program.

When you click Next the config wizard will automatically test the connection to the server.
You will not be able to proceed if the connection test failed.
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Figure 2.8: Select the Power Server (s) and Web Server(s)

-

|_-:|¢ PowerServer Toolkit Configuration Wizard @

] Please select the PowerServer(s) and Web Server(s)
Welcome that your application will be deployed to:

d

B Deploy External Files

Configure basic settings Deployment Profile Mame:  [Local Deployment v]
Selact PBL files PowerS ervers
Configure deployment settings Celected  Mame Edit...
B Select DB t!'rpe__q Local PowerServer
Add. .
W Declare transaction object(s)
) Wweb Servers
B Select image files :
Selected  Mame Edit...
W Select INI files
Local web Server
Add...

Delete

N Summary

< Back ][ Mest = ][ Cancel Finigh

Step 6: Select the database type used by your application and click Next.

When you click Next the config wizard will automatically test the connection with the
database engine. You will not be able to proceed if the connection test failed.

If the required database type has not been configured in Task 1: Configure the database type,
you should highlight the database type, then click Edit, and then follow Step 4 in Task 1.
Configure the database type to configure it.
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Figure 2.9: Select the database type(s)

|_-:|¢ PowerServer Toolkit Configuration Wizard

. Select the database type(s) used by your application:
Welcome

Mate: 'ou must zpecify the databaze type(z] that your application uzes, but it iz not

Configure basic settings necessam to specifiu the exact database(s) used in this particular application. This
_ _ zetting enables PowerServer Toolkit to apply the correct type of database driver for
Select FBL files generating the correct databasze syntax for PowerBuilder SGL statements in the
& application.
Configure deployment settings PF
Select DE types ]
' Ilzed Supported D atabase Types Configured  *
W Declare transaction object(s) W MSSELS erver Mo 1
[l Oracle S Mo 1
i [ Oracle 9 Mo
B Select image files [ SAP ACE Mo
B Select INI files AP oA | Lltralite
] IBM DEZ UDE Mo i
B Deploy Bxternal Files =1 rarn hie

| Edt. || Test

N Summary

< Back ][ Mest = ][ Cancel Finigh

Step 7: Click Add to specify the transaction object(s) used in your application.
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Figure 2.10: Specify the transaction object

|_-:|¢ PowerServer Toolkit Configuration Wizard @

] Please specify the transaction object(s) used in the
Welcome application and the corresponding data source(s):

Configure basic settings . .
g e g5 Tranzaction Object Data Source DB Type

Selact PBL files

Configure deployment settings

Select DE types

Dedlare transaction objeds)

B Select image files

B Select INI files

B Deploy Bxternal Files

Configure. . Add... Delete

N Summary

< Back ][ Mest = ][ Cancel ][ Finigh

Inthe Add Transaction Object window, specify the following settings:

a. Input the transaction object name used by the application to the Transaction Object text
box. Default transaction object for most PB applicationsis SQL CA.

b. Select the database type from the Database Type list box.
c. Select L ocal Power Server from the Power Server dropdown list box.

d. Select the data source from the table. The data source should connect to the same database
that the PowerBuilder application connectsto. If the required data source has not been
configured in Task 2: Configure the database connection, you should click Add, and then
follow Step 4 in Task 2: Configure the database connection to create it.
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Figure 2.11: Select the connection cache

Add Transaction Object

-

=

Tranzaction Object: zglca
Database Type: SAP Sh | Ultralite
Data Source: za_db

gource in the below Data Source group box,

IF pour PowerServer iz the .MET edition, you can alzo select, edit, add, or delete the data

[rata Source
PowerServer: Laocal PowerSemer i
Selected  Mame DB Host
p appeohzample AppeonS ampleForSerer
| appeohzample: AppeonS ample2FarSerer
“ AppeonSample
nu:urthwmu:l 192.0.0.205
Edit. | | 4dd. || Delte |
[ 0k, ] [ Cancel

Tip: If you have more than one transaction object you can add additional transaction objects
by repeating the above steps.

Step 8: Click Browse to select the image file or the folder that contains the image files, if
any. Click Next.

Step 9: Click Add Fileor Add Directory to select the INI file, if any. Click Next.

Step 10: Click Add File or Add Directory to select any other external files such as TXT file
etc., if any. Click Next.

Step 11: In the configuration summary screen, keep the Deploy the application now option
as selected. Click Finish.

Once you click Finish, the Power Server Application Deployment Wizard automatically
starts deploying the application. To manually starts Power Server Application Deployment

Wizard, you can click the Deploy icon ( ! ) on the PowerServer Toolkit.
Step 12: Click Finish when the deployment process is complete.
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Figure 2.12: Application Deployment Wizard_sales

1, PowerServer Deployment Wizard - sales_app — >

Deployment Infarmation

Application deployed: zales_app
Deployment mode: Full &pplication Deplopment
Deployment profile used: Local Deployment

Deplopment Task Summarny

Task Status Time

Tazk 1: Application Source Code Export Completed < 1 Minutes
Tazk 2 PowerServer Application File Generation Completed <1 Minutes
Tazk 3 PowerServer Application Deployment Completed < 1 Minutes
Total Time Elapzed for Automatic Converzion < 3 Minutes

Log Infarmation

“Warnings and Errars Summary: Errars: 0 ; Warnings: [ Wiew Log...
Reports
Features Analysis report available: E Analyziz Report. . i
Finizh Bun... had

2.4 Task 4: Run the Web version of the application (in IE)

Before you run the application on the maobile device, make sure your application can run
successfully in the Internet Explorer Web browser (to aid debugging your application is
automatically deployed as both a Web application using PowerServer Web and a mobile
application using PowerServer Mobile):

Step 1: Open Internet Explorer and navigate to the trusted siteslist (Internet Option >
Security > Trusted Sites > Sites). Uncheck the HTTPS checkbox and add the IP address
of your I1S aswell asthe localhost. For example, if your |P addressis 192.168.1.117 then it
should look as follows:
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Figure2.13: Add thelP addressof IS

i 4
Trustad sites P— = u

You can add and remowve websites from this zone. All websites in
: this zone will use the zone's security settings.

Add this website to the zone:

Add

Websites:
http:f/223.255.243.247
http: /fappcrm.appeon. com

http: /fappeon.gnway.net
http: f/most.doudapp.net

e R N e p—

|| Require server verification (https:) for all sites in this zone

Eemowve

[l »

-_—
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Figure 2.14: Add " localhost"

il N
Trusted sites P— ﬁ

¥ You can add and remove websites from this zone. All websites in
“ this zone will use the zone's security settings.

Add this website to the zone:

Add

Websites:
http://223.255.243.247 -
http: f/appcrm. appeon. com
http: /fappeon.gnway.net
http: /fmost.doudapp. net

O - e

=
1]
o
i

m

-_—

|| Require server verification (https:) for all sites in this zone

Close

e

Step 2: Input the application URL in the Internet Explorer address bar and start the
application. The application URL must contain index.htm, for example http://192.168.1.117/
myA pplication/index.htm.

Note: The application URL is specified in the Web Folder field in Step 1 of Task 3:
Configure and deploy the application.

Step 3: Install the Web browser plug-in, when you are prompted. Y ou will be prompted
twice, please accept both times.

Step 4: When the application is loaded successfully in Internet Explorer, test it carefully.

If you notice any issues, please debug the application according to the Tutoria 3: Develop &
Debug with PowerServer Mobile.

2.5 Task 5: Run the mobile version of the application (on the
Android device)

Now you are ready to run your application on the Android device.

Step 1: Configure the network connection. See Task 4 in Tutorial 1: Set up the Environment.
Step 2: Install Appeon Workspace. See Task 3in Tutorial 1: Set up the Environment.

Step 3: Tap the AppeonM obile icon on your Android device to launch Appeon Workspace.

Step 4: Tap the New icon () to the left of thetitle bar.
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Step 5: In the App URL text box, enter the application URL in this format: http://
server_domain/app_name. For example, if your 11S domain is www.abc.com and you
specified myApplication in the PowerServer Toolkit configuration as the Web folder name
then the URL would be http://www.abc.com/myA pplication/.

Step 6: Tap the Test Connection button to test the server connections. If successful please
proceed to Step 7, otherwise please enter the correct URL.

o
Step 7: Tap the Back icon (Q) on thetitle bar to save the information and return to the main
screen of the Appeon Workspace.

Once you return to the main screen of the Appeon Workspace, the downloading and
installation process of the application occurs automatically.

Step 8: After the installation process has completed, tap the application icon on the main
screen to run the mobile app that isinstalled.
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3 Tutorial 3: Develop & Debug with
PowerServer Mobile

Please keep in mind the following points when devel oping and debugging the PowerServer
mobile applications for the mobile device. For detailed instructions on how to use the
PowerServer Toolkit you may refer to PowerServer Toolkit User Guide.

3.1 Point 1;: Mobile Ul Considerations

Many aspects of the Ul for mobile applications differ significantly from traditional
PowerBuilder best practices. How you layout controls on the window, the size of the
window, controls, and other visual objects, and how the user expects to interact with your
application are fundamentally different for mobile devices.

Please carefully read Chapter 2, Best Practicesin Mobile Ul Design & Development Guide,
including the Window subsection. We have compiled valuable tips and suggestions that will
help you develop user-friendly mobile applications.

Once you have a good understanding of Chapter 2, Best Practicesin Mobile Ul Design
& Development Guide, we strongly recommend using the formulain Section 2.5.1, “Unit
conversion” in Mobile Ul Design & Development Guide to properly size the application
windows and controls to display appropriate on the mobile device.

3.2 Point 2: Unsupported Features

PowerServer Mobile supports nearly al the same features as PowerServer Web. Those
experienced with PowerServer Web know that it supports many powerful PB features. So you
should be able to build equally robust applications with PowerServer Mobile also.

When developing applications for PowerServer Mobile, it is critical to ensure that your
application does not contain unsupported features. PowerServer provides several tools to
assist you with this:

[
Tool 1: The UFA tool (g I) in the PowerServer Toolkit will automatically scan your
application and list major unsupported features found based on a keyword scan.

Tool 2: The Code I nsight tool () in the PowerServer Toolkit will pop-up awindow,
when you are writing dot notation in the PB script editor, that prevents you from writing
PowerScript that is unsupported.

» Tool 3: The Supported PB Features for PowerServer Mobile is a searchable online help
that lists al unsupported features.

These tools have some limitations. Please keep in mind the following limitations when using
these tools:

» The UFA tool uses a keyword scan. As such, not all unsupported features can be found,
especially those that are dynamically occurring in runtime.
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» The Code Insight tool islimited to unsupported PowerScript and essentially based on
keywords (like the UFA tool). As such, it will not prevent all unsupported features from
being added to the application, such as unsupported objects, unsupported expressions, etc.

We recommend you develop your mobile applications with PowerServer Toolkit as follows:

Step 1: Use the Code I nsight tool () from the PowerServer Toolkit to code PowerScript
that is compatible with PowerServer Mobile. For details about how to configure and use the
Code I nsight tool, see Chapter 11, Developing with Code Insight in Power Server Toolkit
User Guide.

|
Step 2: Run the UFA tool (g I) from the PowerServer Toolkit to generate the unsupported
features report. For details about how to run the UFA report, see Chapter 4, Using UFA Tool
in Power Server Toolkit User Guide.

Step 3: Remove or rewrite any unsupported features found by the UFA tool. Please make
note of the unsupported features found such that in the future you do not reintroduce these
same unsupported features.

Step 4: After you have deployed the application, attempt to run the Web version in the
Internet Explorer Web browser. The Web version is based on Power Server Web that has
been on the market for over 10 years. As such, if you find something in your application is
not working in the Web version chances are it is an unsupported feature rather than a product
bug.

Step 5: Since the UFA tool and Code Insight cannot prevent 100% unsupported features,
should you find something that does not work in the Web version please go back to the object
or area of PowerScript in question and cross-reference that with the Supported PB Features
for PowerServer Mobile to see if your application contains any unsupported features.

Step 6: If after cross-referencing the Supported PB Features for PowerServer Mobile you
believe your application is free of unsupported features but it fails to run or operate properly
please contact <support @ppeon. con® for help.

3.3 Point 3: Previewing & Debugging

To preview the application Ul and layout, run the application in Appeon Workspace on the
mobile device. For instructions on installing Appeon Workspace, see Task 3 in Tutorial 1:
Set up the Environment.

To debug the application business logic, first ensure that the UFA report does not contain any
unsupported features, or at least no unsupported features in the area of the application you

are trying to debug. Then, launch the Power Server Debugger (El) from the PowerServer
Toolkit, which will load the Web version of your application in the |IE Web browser.

The Power Server Debugger requires the Microsoft Script debugger to beinstalled on

your system and that your Internet Explorer isversion 9 or later. There are also special
configurations you need to perform in the PowerServer Toolkit and Internet Explorer. Please
see Chapter 6, Debugging Power Server Web applicationsin Power Server Toolkit User Guide
for more information about how to properly configure your environment for the PowerServer
Debugger.
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Please note that Power Server M obile does not contain a mobile-specific debugger, so
we haveincluded the Web debugger in lieu. While not exactly the same, it can still help
to identify problemsin the application business logic or areas that PowerServer Toolkit is
having trouble converting.
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4 Tutorial 4. Package & Distribute Native
Mobile Apps

4.1 Overview

After you successfully deploy a PowerBuilder application to be a native mobile application
using the PowerServer Toolkit, you can choose to run the mobile app immediately in Appeon
Workspace (see Appeon Workspace User Guide for detailed instructions), or package the
app and publish it to the online application store (such as Apple App Store, Google Play

etc.) or distribute it over-the-air (such as by email, Web site etc.). In this section, you will go
through all the required steps for packaging and distributing a PowerServer Mobile app as a
standal one native app.

Note: these steps are also applicable for packaging and distributing A ppeon Workspace, as
intrinsically Appeon Workspace is aso a standal one native mobile app.

4.2 Package & Distribute iOS Apps

Y ou will need to go through the following tasks to package and distribute the PowerServer
Mobile app as a standalone native iOS app.

1. Task 1: Prepare for the build environment.
2. Task 2: Generate the X code project.
3. Task 3: Create the app archive.

4. Task 4: Distribute the app archive

4.2.1 Task 1: Prepare for the build environment

4.2.1.1 Task 1.1: Register for an Apple ID

Follow the onscreen instructions on My Apple ID to create an Apple ID if you do not have
one.

4.2.1.2 Task 1.2: Prepare the Mac machine
Buy a Mac machine and install the latest X code on the Mac machine.

Y ou will need to have a Mac machine with the X code tool installed already to create and
install the distribution certificate and the provisioning profile; run the Xcode project of the
application and create the app archive; distribute the app archive; etc.

4.2.1.2.1 Install Xcode

Click https://devel oper.apple.com/xcode/ to download the latest Xcode, which is 10.1 by the
time of writing.

Sign in with your Apple ID, follow the onscreen instructions to register your Apple ID as an
Apple developer, and download and install the latest X code tool from the above mentioned
website.
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For more information on X code, see the documentation provided on the Apple website.

4.2.1.3 Task 1.3: Enroll in an iOS Developer Program
Enroll in an iOS Developer program at https.//devel oper.apple.com/programs/.

Carefully compare the programs and choose one that suits you best, because different
distribution types (App Store, Ad Hoc, In-Housg, etc.) will be available in different programs,
for example, App Store Distribution isavailable in iOS Developer program only, while I n-
House Distribution isavailablein iOS Developer Enterprise program only.

Below isabrief introduction to the three distribution types that are commonly used (detailed
instructions for these distribution types are provided with in Section 4.2.4, “ Task 4:
Distribute the app archive’):

* App Store Distribution: allows you to submit the app for publication to the Apple App
Store.

Y ou would need to enroll in the iOS Developer program.
Note: Publishing Appeon Workspace to the Apple App Store is unsupported.

* In-House Distribution: allowsyou to install the app to an unlimited number of devices
inside your company.
Y ou would need to enroll in theiOS Developer Enter prise program.

* Ad Hoc Distribution: allows you to install the app on alimited number (up to 100) of
registered devices.

Y ou would need to enroll either in the iOS Developer program or the iOS Developer
Enterprise program. And you would need to register the devices by their unique device ID
(UDID) and add them to the provisioning profile. For details, refer to Registering Devices
Using Member Center in the Apple document App Distribution Guide.

IMPORTANT NOTE:

If you enroll inthe iOS Enter prise Program, you are responsible for managing the
Enterprise Program certificate and provisioning profile. According to the Apple policy,

the iOS Enter prise Program certificates expire after three years and provisioning profiles
expire after one year, which means, before the distribution certificate expires, you will need
to request an additional distribution certificate and replace the expired one, and before the
provisioning profile expires, you will need to renew the provisioning profile using avalid
certificate. Otherwise the mobile app distributed using the enterprise provisioning profile will
not launch after expiration. For more details, refer to Managing Expiring Certificates and
Provisioning Profiles in the Apple document App Distribution Guide.

PowerServer Mobile Tutorials Page 29


https://developer.apple.com/programs/
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/MaintainingProfiles/MaintainingProfiles.html#//apple_ref/doc/uid/TP40012582-CH30-SW10
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/MaintainingProfiles/MaintainingProfiles.html#//apple_ref/doc/uid/TP40012582-CH30-SW10
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/DistributingEnterpriseProgramApps/DistributingEnterpriseProgramApps.html#//apple_ref/doc/uid/TP40012582-CH33-SW13
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/DistributingEnterpriseProgramApps/DistributingEnterpriseProgramApps.html#//apple_ref/doc/uid/TP40012582-CH33-SW13

Tutorial 4: Package & Distribute Native Mobile Apps

Appeon® PowerServer® 2020

Figure4.1: Compare programs
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An App ID isrequired when you create the provisioning profile and when you compile the
Xcode project to be an IPA file later.

An App ID isaunique identifier for the app. It is composed of two parts: the App ID Prefix
and the App ID Suffix (also called Bundle Identifier). The App ID Prefix isa 10-character

hexadecimal string generated by the iOS Certificates, Identifiers & Profiles page. It is unique
to you and your developer account. The App ID Suffix is aname you enter called the Bundle
Identifier. The Bundle Identifier can be explicit or awildcard. Wildcard Bundle IDs are great
for quick development — you do not have to create anew ID for each and every app you test.
We will use wildcard Bundle IDs in this tutorial.

To create an App ID:

Step 1: On your Mac machine, log in to the Apple Developer Member Center with your
Apple ID and password.

Step 2: Click theicon or text next to Certificates, Identifiers & Profiles.
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Figure4.2: Identifiers
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Step 3: Click App I Ds under Identifiers, then click the plus sign (+) button near the top-right
corner.

Figure4.3: Add an App ID
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Step 4: Enter adescription, for example, "My Mobile Apps*, which cannot include special
characters (including most punctuation).

For App ID Prefix, understand that it is automatically generated by the iOS Certificates,
Identifiers & Profiles page.

For App ID Suffix, choose Wildcard App ID to use asingle ID to match multiple
applications. Enter an asterisk (*) asthe last digit of the Bundle ID. For example,
"com.abcexample.*".

Remember the App ID (Prefix & Suffix), especially the App ID Suffix (Bundle ID), asit will
be used in the X code project settings and the iTunes Connect app record.
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Figure 4.4: Information for the App ID

App ID Description

Mams: | My Mobile Apps
You cannot use special characters such az @, & *, ", "

App ID Prefix

“alue: WZLSPTIELSE (Team IDY)

App ID Suffix

Explicit App ID

fyou plan to incorporate app services such az Game Center, In-App Purchaze, Data Protection,
and iCloud, or want a provisicning profile unique to a gingle app, you must register an explicit App
D for your app.

To create an explicit App |D, enter a2 unique string in the Bundle |D fizld. Thiz string should match
the Bundle |ID of your app

L
1]

[41]
m
=]

*  Wildcard App 1D

This allows you to use a single App 1D to match multiple apps. To create a wildcard App 1D, enter an
asterisk (*) as the last digit in the Bundls 1D field.

Bundle 1D: | com.abcexample.¥|

Example: com.domainname.*

Step 5: Click Continue.
Step 6: Confirm the App ID information and click Register.

4.2.1.5 Task 1.5: Create & install a distribution certificate

A distribution certificate is required to sign the code and create an app for testing and
submitting to the Apple Store etc.; it is different from a devel opment certificate which is used
for development purpose in Xcode. Y ou must have avalid distribution certificate linked to a
distribution provisioning profile.
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Note that if you use an iOS Enter prise Program distribution certificate, the certificate
will expire after three years, you will need to request an additional certificate to replace the
old one before expiration. For more, refer to Requesting Additional Enterprise Distribution
Certificates in the Apple document App Distribution Guide.

4.2.1.5.1 Create a CSR file

To generate adistribution certificate, you will first need to create a Certificate Signing
Request (CSR) from your Mac. Follow the instructions below to create a CSR file using
Keychain Access.

To create aCSR file:

Step 1: Open Finder on your Mac, select the Application folder, then open the Utilities
folder, and launch Keychain Access.

Figure 4.5: Utilitiesfolder

enon (3% Applications o

[« | » | é,m]ulll][gv][ﬁ-v][l'ﬂ][@] Q -

FAVORITES P J LA B
,_'l% All My Files Mail Maps Messages Mission Caontrol

i Applications

[l Desktop p— |
[ Documents g m G
) Downloads = =

DEVICES MNotes Photo Booth Preview QuickTime Player

= Y .
() Remote Disc

SHARED m
L] apple's iMac AT At
= “appeon”f"Mac... Reminders Stickies System Preferences

= "appeon"fi"Mac...
= HO8Macmini

= macmin221 j
= sun-mac — LA
= sunz TextEdit Time Machine [ Utilities Xcode
LAl

PowerServer Mobile Tutorials Page 33


https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/DistributingEnterpriseProgramApps/DistributingEnterpriseProgramApps.html#//apple_ref/doc/uid/TP40012582-CH33-SW4
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/DistributingEnterpriseProgramApps/DistributingEnterpriseProgramApps.html#//apple_ref/doc/uid/TP40012582-CH33-SW4

Tutorial 4: Package & Distribute Native Mobile Apps

Appeon® PowerServer® 2020

Figure 4.6: Keychain Access application
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Step 2: Within the Keychain Access drop down menu, select Keychain Access > Certificate
Assistant > Request a Certificate from a Certificate Authority.

Figure4.7: Request a certificate from a certificate authority
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Step 3: In the Keychain I nfor mation window, enter the following information:

In the User Email Addressfield, enter your email address. Use the same email address
you used to register in the iOS Developer Program.

In the Common Name field, create a name for your private key.

The CA Email Addressfield should be left empty.

In the "Request is" group, select the "Save to disk" option.

Step 4: Click Continue.

Figure 4.8: Certificate information

800 Certificate Assistant

Certificate Information

Enter information for the certificate you are requesting. Click
Continue to request a certificate from the CA.

User Email Address:| | support@abc.com L

Commaon Name:| ABC Corporatinrl

CA Email Address:

Request is: | | Emailed to the CA
(») Saved to disk |

Let me specify key pair information

Continue

Step 5: Click Save to save the CSR file to your Mac desktop.

Y ou will need to upload this CSR file when you create the distribution certificate in the next
section.
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Figure 4.9: Save CSR to Desktop
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4.2.1.5.2 Create & install a distribution certificate

Now you should go back to the Apple Developer Member Center to create a distribution
certificate.

Step 1: In the Certificates, | dentifiers & Profiles page of the Member Center, choose
Certificates> Production, then click the plus sign (+) button near the top-right corner.

Figure 4.10: Add a certificate

i0S, tvOS, watchOS v i0S Certificates (Production) +/|Q
Certificates 1 Certificates Total
all Name Type Expires
Pending . -
Appeon Inc. OS Distribution Mar 04, 2012
Development

| Production |

Step 2: First drag down the page and click Worldwide Developer Relations Certificate
Authority to download AppleWWDRCA .cer to your Mac.
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Figure 4.11: Download the AppleWWDRCA .cer

[ NGNs] Add - i0S Certificates - Apple Developer e

(4> | (][ + | @ Appleinc. @ developer.apple.com ¢ | Reader |

[I] 2 Apple iCloud Facebook Twitter Wikipedia Yahoo News™ Popular ™ F—
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) Webhsite Push ID Certificate
Sign and send updates for Websites.

) VolP Services Certificate

Establish connectivity between your server and the VolP service. A separate certificate is
requried for each VolP app you distribute.

) Apple Pay Certificate
Decrypt app transaction data sent by Apple to a merchant/developer.

Intermediate Certificates

To use your certificates, you must have the intermediate signing certificate in your system
keychain. This is automatically installed by Xcode. However, if you need to reinstall the
intermediate signing certificate click the link below:

@ Worldwide Developer Relations Certificate Authority

Copyright @ 2014 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

Then click AppleWWDRCA .cer in the Downloads folder on your Mac to add the certificate
to Keychain Access. Y ou should be able to see the "Apple Worldwide Developer Relations
Certificate Authority” certificate listed in the Keychain Access window.

Step 3: Return to the page for adding the iOS certificate, select a certificate type (App Store
and Ad Hoc), then click Continue.
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Figure4.12: App Storeand Ad Hoc distribution
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) Apple Push Notification service SSL (Sandbox)

App Groups
Establish connectivity between your notification server and the Apple Push Notification service
R sandbox environment. A separate certificate is required for each app you develop.
[ Devices
All
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Provisioning Profiles
Al (= App Store and Ad Hoc
Development Sign your i0S app for submission to the App Store or for Ad Hoc distribution.

Distribution
) Apple Push Notification service S5L (Production)

Establish connectivity between your notification server and the Apple Push Notification service
production environment. A separate certificate is required for each app you distribute.

) Pass Type ID Certificate
Sign and send updates to passes in Passbook.

Step 4: If you have already created a Certificate Signing Request (CSR) file in the previous
section, click Continue to upload the CSR file. If not, you could follow the directions on this
page or in the previous section Create a CSR file to create one.

Step 5: Click Choose Fileto select your CSR and click Gener ate.
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Figure4.13: Upload CSR file
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Figure 4.14: Generate a certificate
Select Type Request Generate Download
Corrtifioate .
- Generate your certificate.

With the creation of your CSR, Keychain Access simultaneously generated a public and private
key pair. Your private key is stored on your Mac in the login Keychain by default and can be
viewed in the Keychain Access application under the "Keys" category. Your requested
certificate will be the public half of your key pair.

Upload C5R file.
Select .certSigningReguest file saved on your Mac.

Choose File... |:| CertificateSigningRequest.certSigningRequest
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Step 6: Click Download to download the distribution certificate to your Mac.

The distribution certificate (ios_distribution.cer) appearsin your Downloads folder on your

Mac.

Figure 4.15: Download Distribution Certificate
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Your certificate is ready.

Download, Install and Backup
Download your certificate to your Mac, then double click the .cer file to install in Keychain
Access. Make sure to save a backup copy of your private and public keys somewhere secure.

e Name: 105 Distribution: Appeon Carporation (HK) Limited
Corrtifierte:
Monosslare Type: i05 Distribution
Expires: Dec 02, 2015
Download

Documentation
For more information on using and managing your certificates read:

App Distribution Guide

Add Another Done

Step 7: Click the distribution certificate (ios_distribution.cer) in the Downloads folder on
your Mac to add it to Keychain Access. The certificate isthen listed in the Keychain Access
window, as shown in the following figure.

Remember the name of the certificate, as you will need to useit later when creating the iOS
application archive (1PA) file.
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Figure4.16: Installed Certificate
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4.2.1.6 Task 1.6: Create & install a distribution provisioning profile

Depending on how you will distribute the app (App Store, In-House, or Ad Hoc), you need to
create different distribution provisioning profiles.

The steps for creating the different distribution provisioning profiles are similar. To create a
Stor e provisioning profile or an In-House provisioning profile, you select 1) an App ID and
2) asingle distribution certificate. To create an Ad Hoc provisioning profile, you select 1)
an App ID, 2) asingle distribution certificate, and 3) multiple test devices. For details, refer
to the below steps, or refer to Creating Store Provisioning Profiles, and Creating Ad Hoc
Provisioning Profiles in the Apple document App Distribution Guide.

Step 1: Go back to Certificates, |dentifiers & Profiles, scroll down to the end of the left
navigation pane and choose Provisioning Profiles > Distribution, and then click the add

icon ( ).
Step 2: Select a distribution type and click Continuein the Select Typetag.

Y ou will be provided with different distribution types according to the programs you enrolled
in. If you enrolled in theiOS Developer Program, you would choose between App Store
and Ad Hog; if you enrolled in the iOS Developer Enter prise Program, you would choose
between Ad Hoc and In-House.

Note that the In-House or Ad Hoc provisioning profile that is created using the iOS
Enter prise Program distribution certificate will expire after one year. Y ou will need to
renew the provisioning profile before expiration, otherwise the maobile app distributed using
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these provisioning profiles will not launch after expiration. For more, refer to Renewing
Expired Provisioning Profilesin the Apple document App Distribution Guide.

Step 3: Select your App ID and click Continue.

Step 4: Select the distribution certificate you have created in Task 1.4: Create & install
distribution certificates and click Continue.

Step 5: Select the devices you want to use for testing, and click Continue.

Note: Thisstepisonly required if you create the Ad Hoc provisioning profile.

Step 6: Enter a profile name and click Gener ate.

Step 7: After the profileis generated, click Download to download and use it.

Step 8: Double-click the downloaded file to install the provisioning profile in Xcode.

Now that you have finished creating and installing the distribution certificate and the
provisioning profile containing code signing, you are ready to create the app archive.

4.2.2 Task 2: Generate the Xcode project

Step 1: On the PowerServer Toolkit machine, use the Package tool in the PowerServer
Toolkit to package the app files into an X code project.

Y ou can select Package a Stand-alone Mobile Project (for packaging a PowerServer
mobile app as a mobile project) or Customize and Package Appeon Wor kspace (for
packaging the Appeon Workspace as a mobile project) to package the app files into an Xcode
project, and the steps (in this task as well as the subsequent tasks) are the same for both
projects.

During the package process, you will be able to specify the settings, such as the app name,
icons, etc., that are required by the Xcode project. See Section 9.2, “ Packaging a stand-
alone mobile project” in Power Server Toolkit User Guide or Section 9.3, “ Customizing and
packaging Appeon Workspace” in Power Server Toolkit User Guide for detailed instructions.

After the package process is complete, you will find the following two zip packages
generated under the specified destination folder.
» The zip package of the application.

» AppeonMobile.framework.zip: this zip package is necessary for all apps (including the
customized A ppeon Workspace) to be distributed on iOS.

These two zip packages are compressed according to the standard of Mac, therefore, they
have to be decompressed on the Mac machine.

Step 2: Copy the above two zip packages to the Mac machine.
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Figure4.17: Zip packages on the Mac machine
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Step 3: On the Mac machine, extract the above two zip packages respectively.

Figure 4.18: Extracted packages on the Mac machine
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Step 4: Copy all of the files under the extracted AppeonM obile.framework folder into the
refer ence folder under the extracted app package.

The following screenshot shows the location of the r efer ence folder under the extracted app
package.

Figure 4.19: L ocation of the reference folder

o @ reference
< 22 éﬂunu my %y M| O Qi Search
Favorites M Appeon_Mo...utorials.chm EonNativeApp >
AppeonMobile.framework * g EonNativeApp.xcodeproj
E Recents I ) ; .
AppeonMo..amework.zip keychainac...sgroups.plist
A Applications salesmobile >
© Downloads I' salesmobile.zip
@ AirDrop
] Desktop
<7 iCloud Drive
[ Documents

PowerServer Mobile Tutorials Page 43



Tutorial 4: Package & Distribute Native Mobile Apps Appeon® PowerServer® 2020

The following screenshot shows the filesin the r efer ence folder after copied from the
AppeonM obile.framework folder.

Figure 4.20: Files contained in thereference folder
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Make sure you do Step 3 & 4 on the Mac machine, not on the Windows machine.

4.2.3 Task 3: Create the app archive

4.2.3.1 Task 3.1: Set Bundle Identifier

In order for the apps running on the same mobile device to be recognized as running on one
device not on multiple devices by the Appeon Licensefile, you will need to always input

the same App ID for al apps and specify the same bundle identifier for the same app. For
details, refer to Section 4.3.4.1.1, “Product Activation” in Power Server Configuration Guide
for .NET or in PowerServer Configuration Guide for J2EE.

The App ID is made up of two parts: App ID Prefix + App ID Suffix (Bundle Identifier),
in thisformat "ApplDPrefix.Bundleldentifier”, take VZ5P796L S6.com.abcexample.1
for example, VZ5P796L S6 isthe App ID Prefix, com.abcexample.l isthe App ID Suffix
(Bundle Identifier).

Y ou would need to modify the Bundle Identifier in the Xcode project settings to match with
what you have specified when creating the App ID (in Task 1.4: Create an App ID).

Follow steps below to specify the consistent Bundle Identifier in the project settings:

Step 1: Double click the EonNativeApp.xcodepr oj file from the package to open the project
in Xcode.

Step 2: Select the project or target, then select the General tab on the right, and then input the
bundle identifier in the Bundle I dentifier field.

If you specify awildcard bundle identifier when creating the App 1D, you will need to
replace "*" with an explicit string, for example, com.abcexample.1 or com.abcexample.appl
etc.
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Figure4.21: Bundle Identifier in General tab
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Also make sure the same Bundle | dentifier isinput when uploading the app to the App Store
in the later steps.

If you want to make change to the Bundle I dentifier, please make sure the same Bundle
Identifier isused consistently in the General tab and the App Store upload process.

4.2.3.2 Task 3.2: Code sign the app

Y ou now code sign the app with the signing certificate contained in the corresponding
provisioning profile.

To set the code signing identity to the certificate:

Select the project or target, then select the Build Settings tab on the right, drag down

the screen to find the Signing group, make sure Code Signing I dentity is set to the
corresponding distribution certificate (identified by your App ID), and Provisioning Profile
is set to the corresponding provisioning profile.

Figure 4.22: Code signing
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4.2.3.3 Task 3.3: Review the archive scheme settings

Y ou would need to double check the scheme settings to ensure you do not archive a debug
version of the app.

To review the archive scheme:

Step 1: From the X code dropdown menu, choose Product > Scheme > Edit Scheme to open
the scheme editor, as shown in the following figure.

Figure 4.23: Edit Scheme

or m Debug Source Control Window Help

Run #R 55 am 1
lative  Profile I
Analyze 3B
' § Build Settings
d ~
° | Build For » <
"9t perform Action > i0s8.00
Build B

Clean Build Folder {+3K

| g EonNativeApp

Scheme > Choose Scheme ~0
Destination =
Create Bot...

Edit Scheme... #<

»r Paths (Deprecated) e G

Manage Schemes...

v/ EonNativeApp

Step 2: In the scheme editor, do the following:

=

. Onthetop left panel, select GenericiOS Device.

N

. In theleft column, select Archive;

3. Make sure Release (not Debug) is selected from Build Configuration;

D

. Modify the archive name or use the default name in the Archive Name field.

5. Click Closeto save the settings.

PowerServer Mobile Tutorials Page 46



Tutorial 4: Package & Distribute Native Mobile Apps Appeon® PowerServer® 2020

Figure 4.24: Archive Release

C—] EonNativeApp ) ?‘ Generic i0OS Device

, pBuild
1 targat Build Configuration  Release [T}
> » Run
| Debug Archive Name  salesmobile-abcexample_com-11_0_1975_C
Test .
> f Debug Options Reveal Archive in Organizer
Profile
» M eieace
Analyze
> E Debug

Archive
| 2
Release

Duplicate Scheme Manage Schemes... Shared " Close ™|

Step 3: (Optional) Select the project or target, then select the General tab on theright,

and then configure the X code project for distribution. All the information specified in the
Power Server Toolkit Package tool can be reconfigured here and you can also configure
those that are not listed in the Power Server Toolkit Package tool (because only the required
information are listed for configuration in the Power Server Toolkit Package tool).

For details about how to configure the settings in Xcode, read Configuring Y our Xcode
Project for Distribution in the Apple document App Distribution Guide.

4.2.3.4 Task 3.4: Create the archive
Now you are ready to create an app archive.
Step 1: Select the project in the Xcode project navigator.

Step 2: From the X code dropdown menu, choose Product > Archive. (If thisoptionis
not available, double check that GenericiOS Deviceis selected in menu: Product >
Destination)

Figure 4.25: Archive

or [N Window _Help
Run
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If aprompt appears asking whether code sign can sign the app using akey in your keychain,
input the password and click Allow or Always Allow.

After the project is built successfully, it will appear in the Archives window, as shown
below.

Now the app archiveisready. You can click Distribute App in the Archives window
to submit the archive to the Apple App Store or save the file for enterprise or Ad-Hoc
distribution.

Figure 4.26: Archivelist

[ NoN ] Crashes Energy
i0S Apps Name Creation Date ~ Version Archive Information
ij EonNativeApp l salesmobile-abcexample_com-11_0... Jan 18, 2019 at 1:39 AM 1.0 (1.0)

% salesmobile-abcexa mpl...
AT

(& Jan 18, 2019 at 1:39 AM

Distribute Ap

Validate App

Details
Version 1.0 (1.0)
Identifier com.abcexample.1
Type I0S App Archive
Team VZ5P796LS6

Download Debug Symbols

Description

4.2.3.5 (Optional) Import the certificate

MobiLink supports the encrypted transmission of the synchronous data stream by using
HTTPS. If you want to use HTTPS for the encrypted transmission of the synchronous
data stream, you should add the certificate file into the project. The following steps take
EonNativeApp as an example.

1. Right click EonNativeApp and select Add Filesto " EonNativeApp..." to choose the
certificate file, as shown in the following figure.
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Figure4.27: Add filesto " EonNativeApp"
® Grab File Edit Capture Window Help A D a2 w

1 EonNativeApp.xcodeproj
b :.i\ EonNativeApp ; iPad ; iOS 6.0 EonNativeApp: Ready | Today at 10:3: 1

EonNativeApp.xcodeproj

T QO A ©& = = B8 |[ui|a p|[conNativespp
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» images Open with Exter Ed
» [ | EonNativeApp Open As >
> Framewnnc Show File |HS|)ECTOI’ Bundle Identifier | com.appeon.mebile.FoniativeApp
> Products .
New File... Version | 1.0
New Project... )
Add Files to "EonNativeApp"... Build 1.0
Team | None
New Group
New Group from Selection
Sort by Name Dol . o
eployment Target v
Sort by Type pley B
Devices | Universal
Find in Selected Groups...
T T —
Source Control » (_fPhone ) iPad
Project Navigator Help >
| Main Interface | MainStorybeard_iPhone -
| Device Orientation ¥/ Portrait
v Upside Down
v Landscape Left
v Landscape Right
Status Bar Style | Default
Hide during application launch
@ e

2. Inthis example, choose the cer.pem.cer file. Make sure to select the Copy itemsinto
destination group'sfolder (if needed) checkbox, as shown in the following figure. Click
Add.
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O s
= can
1 EonNativeApp.xcodeproj
a}\: EonNativeApp : iPad ; i05 6.0 EonNativeApp: Ready | Today at F510:34 A1
_‘l EonNativeApp.xcodeproj |
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1 = + = app URL Crn
» || EonNativeApp = All My Files -
. 1 — o (] Appeon Mobile devl.0 = w
& {—JP e rﬂq Applications (1] Appeon Mobile devl.s =
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Desktop M appeondb.db Name cert.pem.cer
B Doc o D Cert.pem.cer Kind certificate
S _ dbmlsync.txt Size 644 bytes
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B Movies L hltpie" Modified 2013f10A23H F44:16
m— n Last opened 4% L£F9:16
J3 Music (3 hups " ’
' https.zip

¥ Deploy @ pi
Pictures (] integratio...lone_install = |,

@ﬂ Copy items into destination group's folder (if needed)

Folders (*)Create groups for any added folders
) Create folder references for any added folders

Add to targets v/ A, EonNativeApp

| New Folder | | Cancel | | Add |

+| @Ba®

3. The certificate file is added successfully and is placed in the position parallel to other
folders under the EonNativeApp directory, as shown in the following figure.

Figure 4.29: The certificatefileisadded successfully.

;EonNativeApp.xcodeproj — | cert.pem.cer

’ [ r;l\; EonMativeApp » iPhone ; i05 6.0 EonMativeApp: Ready | Today at T4 1:22
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| |images st 1
.
b | | EonNativeApp
b | | Frameworks
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Country 1
StatefProvince 1
Locality 1
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Organizational Unit 1
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Issuer Name
Country 1
State/Province 1
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Organization 1
Organizational Unit 1
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Serial Mumber 00 DB DA 12 C6 94 81 4191 91 E3 5D 0A 4F 6A DA EB
Version 3
Signature Algorithm SHA-1 with RSA Encryption ( 1.2.840.113549.1.1.5)
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4.2.3.6 Additional settings for Xcode 9

If you use Xcode 9 to create the app archive, make sure that you also configure the following

Xcode 9 settings:

Setting 1: Clear the selection of the Automatically manage signing check box. It is selected

by default in Xcode 9.

Figure 4.30: Automatically manage signing
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Setting 2: Select the corresponding provisioning profile from Signing (Debug) and Signing

(Release) sections.
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Figure 4.31: Signing (Debug)
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Setting 3: Select the corresponding provisioning profile under the Provisioning Profile
(Deprecated) section as well.

Figure 4.32: Provisioning Profile (Deprecated)
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Setting 4: If you are archiving Appeon Workspace, modify the bundle identifier under the
Product Bundle Identifier section aswell.
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Figure 4.33: Product Bundle Identifier
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4.2.4 Task 4: Distribute the app archive

Xcode alows you to distribute the app archive in the following methods:

» App Store distribution: submits the app for publication to the Apple App Store. Refer to
Section 4.2.4.1, “Method 1: App Store distribution” for detailed instructions.

* In-House distribution: installs the app to an unlimited number of devicesinside your
company. Refer to Section 4.2.4.2, “Method 2: In-house or Ad-Hoc distribution” for

detailed instructions.

» Ad Hoc distribution: installs the app on alimited number (up to 100) of registered devices.
Refer to Section 4.2.4.2, “Method 2: In-house or Ad-Hoc distribution” for detailed

instructions.

The detailed instructions for Ad Hoc distribution and In-House distribution are the same,

though their provisioning profiles are different.

4.2.4.1 Method 1: App Store distribution
To submit the app archive to the iOS App Store:

Step 1: In the Archives organizer, select the application archive, and click Distribute App.

Step 2: Select iOS App Store and then follow the instructions on screen.

For more instructions, refer to Submitting Y our App to the Store in the Apple document App

Distribution Guide.

4.2.4.2 Method 2: In-house or Ad-Hoc distribution

To export the app archive and distribute it outside the iOS App Store:
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Step 1: In the Archives organizer, select the application archive, and click Distribute App.

Optionally, you can click Validate before clicking Distribute App, to validate the archive
and fix any problems before exporting it.

Step 2: In the dialog that appears, select a distribution method and then following the on-
screen instructions.

» Todistribute the app archive using ad hoc provisioning (where the app runs on registered
test devices only), select Ad Hoc.

» Todistribute the iOS Developer Enterprise application, select Enterprise or
Development.

To learn more about ad hoc deployment, refer to Distributing Y our App Using Ad Hoc
Provisioning in the Apple document App Distribution Guide.

To learn more about the iOS Enterprise application, refer to Distributing iOS Devel oper
Enterprise Program Applications in the Apple document App Distribution Guide.

Y ou can send the app to your usersin the following four ways:

 Distribute the .ipafile and .plist file to your users, and users perform the installation using
iTunes. See the section called “Install apps using iTunes’ for detailed instructions.

» Digtribute the .ipafile and .plist file to your users, and users perform the installation using
iPhone Configuration Utility or Apple Configurator (Using Apple Configurator isleft
out in thistutorial). See the section called “Install apps using iPhone Configuration Utility”
for detailed instructions.

» Post the .ipafileand .plist file on a secure Web server, and users perform the installation
wirelessly. See the section called “Install appswirelessly” for detailed instructions.

» Useyour MDM server to instruct managed devicesto install the app, if your MDM server
supportsit. Thisisleft out in thistutorial.

4.2.4.2.1 Install apps using iTunes

Step 1: Copy the .ipafile for the app to a machine (either Windows or Mac) with iTunes
aready installed.

Step 2: IniTunes, choose File> Add to Library, and then select the .ipafile.

Step 3: Connect a device to the computer, and then select it in the Device list iniTunes.
Step 4: Click the Appstab, and then select the Sync Apps checkbox and the app in the list.
Step 5: Click Apply (or Sync).

If your user's computers are managed, you can deploy the files to their computers and ask
them to sync their device. iTunes automatically installs the files found in iTunes Mobile
Application and Provisioning Profiles folders.

4.2.4.2.2 Install apps using iPhone Configuration Utility

Step 1: Copy the .ipafile for the app to a machine (either Windows or Mac) with iPhone
Configuration Utility already installed.

PowerServer Mobile Tutorials Page 54


https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/TestingYouriOSApp/TestingYouriOSApp.html#//apple_ref/doc/uid/TP40012582-CH8-SW4
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/TestingYouriOSApp/TestingYouriOSApp.html#//apple_ref/doc/uid/TP40012582-CH8-SW4
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/DistributingEnterpriseProgramApps/DistributingEnterpriseProgramApps.html#//apple_ref/doc/uid/TP40012582-CH33-SW1
https://developer.apple.com/library/ios/documentation/IDEs/Conceptual/AppDistributionGuide/DistributingEnterpriseProgramApps/DistributingEnterpriseProgramApps.html#//apple_ref/doc/uid/TP40012582-CH33-SW1

Tutorial 4: Package & Distribute Native Mobile Apps Appeon® PowerServer® 2020

Step 2: IniPhone Configuration Utility, choose File> Add to Library, and then select
the .ipafile.

Step 3: Connect a device to the computer, and then select it in the Device list.
Step 4: Click the Applications tab, and then select the .ipafile.
Step 5: Click Install.

4.2.4.2.3 Install apps wirelessly
Before installing the app, you will need to first post the app to aWeb server.

Step 1. Construct and configure the server.
1. Install 11S on the server.

2. Copy the app (.ipa) file, the manifest (.plist) file, and the icons to alocation on the I1S
website that is accessible to the users.

3. Create a page that links to the manifest file.
Hereisasamplelink:

<a href="itnms-services://?acti on=downl oad- mani f est &ur| =htt p: // exanpl e. com ?
mani fest. plist">lnstall App</a>

Step 2: Set the MIME type of the server, so the server can correctly transfer the manifest file
and the application.

» For Mac OS X Server, use the Server Admin to add the following MIME types to the Web
service's MIME Types settings:
application/octet-stream ipa
text/xml plist

» For IS, use the IIS Manager to add the following MIME types on the server's Properties
page:

.ipa application/octet-stream
plist text/xml

Now your app isready for installation.
Step 3: Distribute the URL for downloading the manifest file by SMS or email to the users.

Step 4: The user clicks the URL to download the manifest file from the website to the iOS
device, and the manifest file instructs the device to download and install the apps referenced
in the manifest file.

4.3 Package & Distribute Android Apps

Compared to 10S apps, the steps for packaging and distributing the Android apps are alot
simpler. Once you package the app files using the PowerServer Toolkit, you will get an
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Android application package (APK) that can readily be distributed using any approach,
including publishing in the Android app marketplace such as Google Play, or serving the app
from a Web site or emailing the app directly to users.

Therefore, you need to go through the following two tasks mainly.
1. Task 1. Generate the Android project.
2. Task 2: Generate the Android application package (APK).

3. Task 3: Distribute the Android APK.

4.3.1 Task 1: Generate the Android project

On the PowerServer Toolkit machine, use the Package tool in the PowerServer Toolkit to
package the app filesinto an Android project.

Y ou can select Package a Stand-alone Mobile Project or Customize and Package Appeon
Wor kspace to package the app filesinto an Android project. During the package process,
you can press F1 to get help on the fields. See Section 9.2, “Packaging a stand-alone mobile
project” in Power Server Toolkit User Guide or Section 9.3, “Customizing and packaging
Appeon Workspace” in Power Server Toolkit User Guide for detailed instructions.

After the package process is complete, you will find the Android project files generated under
the specified destination folder.

4.3.2 Task 2: Generate the Android application package (APK)

Step 1: Prepare a machine that meets the following requirements and make sure it has
Internet access.

The machine must be installed with the following software and hardware configurations:
* Windows 7/8/10 (32-bit or 64-bit) or Mac OS X 10.10 thru 10.14

* 4GB RAM minimum

» 2 GB of available disk space minimum

Step 2: Download the Android Studio setup program from here, and then install Android
Studio by following instructions here. The machine must have Internet access to complete the
installation.

By the time of writing this document, the most current version is Android Studio 3.5.3. This
version requires SDK Build Tools 28.0.3 or higher and Gradle 5.4.1 or higher.

Step 3: Open the Android project generated in Task 1: from Android Studio, select the project
folder to load the entire project.

Step 4: In Android Studio, open the build.gradle file and get the required versions for SDK
and build tools.

For Android Studio 3.5.3, the SDK must be version 28, and the build tools must be version
28.0.3.
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Figure 4.34: build.gradle
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Step 5: Select Tools | SDK Manager from the menu, and then install the required SDK and
build tools.

Inthe SDK Platformstab, select Android 9.0 (28).

Figure 4.35: SDK platforms
[ Setll'n-gs_f'nﬁewpmj? —El

-
Qe Appearance & Behavior * System Settings * Android SDK Reset
Appearance & Behavior Manager for the Android SDK and Tools used by Android Studio
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LR SDK Platforms  SDK Tools  SDK Update Sites
Systemn Settings
Passwords Each Android SDK Platform package includes the Andreid platform and sources pertaining to an API level by
default. Once installed, Android Studio will automatically check for updates. Check "show package details” to
HTTP Proxy display individual SDK components.
Data Sharing Name API Level Revision Status
Android 10.0 () 29 3 Installed
Updates v Android 9.0 (Pi) 28 [ Not installed
Mermory Settings [_] Android 8.1 (Oreo) 27 3 Not installed
= B Android 8.0 (Oreo) 26 2 Mot installed
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Notifications [] Android 7.0 (Mougat) 24 2 Not installed
B Andreid 8.0 (Marshmallow) 23 3 Mot installed
Quick Lists (] Android 5.1 (Lollipap) 2 2 Not installed
Path Variables [_] Android 5.0 (Lollipop) a | 2 Not installed
[ Android 4.4W (Kitkat Wear) 20 2 Mot installed
Keymap [ Android 4.4 (KitKat) 19 4 Mot installed
Editor [_] Android 4.2 (Jelly Bean) 18 3 Not installed
. B Android 4.2 (Jelly Bean) 17 3 Mot installed
Flugins [_] Android 4.1 (Jelly Bean) 16 5 Not installed
i Build, Execution, Deployment [] Android 4.0.3 (IceCreamSandwich) 15 5 Not installed
. B Android 4.0 (IceCreamSandwich) 14 4 Mot installed
Katlin [[] Android 3.2 (Honeycomb) 13 1 Not installed
Tools [_] Android 3.1 (Honeycomb) 12 3 Not installed
U [ Android 3.0 (Heneycomb) 11 2 Mot installed
B Android 2.3.3 (Gingerbread) 10 2 Mot installed
(| B Android 2.3 (Gingerbread) 9 2 Mot installed
| B Android 2.2 (Froyo) 8 3 Mot installed
i [ Android 2.1 (Eclair) 7 3 Mot installed
Hide Obsolete Packages [ Show Package Details
{ “ Cancel Apply Help
[l (|

= = — — = —
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Inthe SDK Toolstab, select Android SDK Build-Tools 28.0.3.

Figure 4.36: SDK tools

o - T—
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Below are the available SDK developer tools. Once installed, Android Studio will autematically check for updates.
Fesmieris Check "show package details” to display available versions of an SDK Tool.
EUEE MName Version Status
Data Sharing & Android SDK Build-Tools
[ ]2201 2201 Not installed
Updates 12301 2301 Not installed
Memory Settings \;l 23.0.2 23.0.2 Not installed
ey L ]23.03 2303 Mot installed
[ 200 200 Not nstlled
Notifications []2401 24.01 Not installed
b []2402 2402 Not installed
Al ] 2403 2403 Not installed
Path Variables [] 2500 25.00 Not installed
2501 2501 Mot installed
Keymap 2502 2502 Not installed
Editor []2503 25.0.3 Not installed
. 2600 2600 Mot installed
Plugins 2601 2601 Not installed
Build, Execution, Deployment \;I 26.0.2 26.0.2 Not installed
. 12603 2603 Mot installed
LTl ] 2100 27.00 Not installed
Tools [J270a 2701 Not installed
i 2102 2702 Mot installed
[]2703 2703 Not installed
2800 2800 Mot installed
2801 2801 Mot installed
[ 2802 28.0.2 Mot installed
Hide Obsolete Packages Show Package Details
“ Cancel Apply Help

Click OK to begin install.
Step 6: Configure the version of the Android Gradle plugin and the Gradle.

The version of Android Gradle plugin required by Android 3.5.3 is 3.5.3, and the version
of Gradle required by Android Gradle plugin 3.5.3is5.4.1. If the Android Studio is not
version 3.5.3, make sure you change the versions of Android Gradle plugin and Gradle
correspondingly.

The following lines set the plugin to version 3.5.3 in the build.gradle file:

dependenci es {

cl asspath 'com androi d. tool s. bui | d: gradl e: 3. 5. 3'
}

The following line sets the Gradle to version 5.4.1 in the gradle/wrapper/gradle-
wrapper.propertiesfile:

distributionUrl=https\://services.gradle.org/distributions/gradle-5.4.1-all.zip

Step 7: Select the build type (debug or release) in the Build Variants window (to open the
Build Variants window, select View | Tool Windows | Build Variants from the menu.
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Figure 4.37: SDK tools
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Step 8: Build the APK file by selecting Build | Build Bundle(s) / APK(s) | Build APK(s)
from the menu.

Make sure the machine has Internet access during the build process.

Y ou can find the APK file generated under the Build > Outputs > APK folder in the Project
view.

4.3.3 Task 3: Distribute the Android APK

This section only highlights three distribution approaches. For more detail s about these three
approaches, refer to http://devel oper.android.com/distribute/open.html.

« Distributing through an App Marketplace.

For detailed instructions on how to publish on Google Play -- the premier marketplace
for Android apps, refer to http://devel oper.android.com/distribute/googl eplay/publish/
index.html.

* Distributing your application through email

* Distributing through aweb site
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5 Tutorial 5: Configure PowerServer Cluster

(Note: This chapter is applicable for both PowerServer Web and PowerServer Mobile,
although it'slisted in the PowerServer Mobile Tutorials document.)

PowerServer provides its own tools and plug-ins to configure a PowerServer cluster
and implement the load balancing and failover functionalities. A PowerServer cluster is
essentially a group of application servers, each with PowerServer installed.

Following are high-level steps for configuring a PowerServer cluster. For detailed
instructions, you may need to go through the documents and sections as specified below.
1. Task 1: Get to understand the architecture of a PowerServer cluster.

2. Task 2: Install PowerServer to multiple application servers.

3. Task 3: Create the PowerServer cluster in AEM.

4. Task 4: Configure the Web server for the PowerServer cluster.

5. Task 5: Install a PowerServer application to the PowerServer cluster and Web server(s).

5.1 Task 1: Understand the cluster architecture

The following graphic illustrates the architecture of the client, the Web server cluster, and the
PowerServer cluster.

» The Web server can be a cluster of Web servers or asingle Web server, depending on the
demands. Configuring the Web server cluster is not a PowerServer task, therefore, it is not
mentioned in any PowerServer documentation; to explore this topic, you could refer to
the user documents provided by the Web server vendor. Generally, asingle Web server is
sufficient to support the PowerServer cluster.

» Appeon cluster plug-in isinstalled to the Web server (either asingle Web server or a
cluster of Web servers), for distributing the user requests to the PowerServer according to
the specified load balancing settings and the failover settings.

* If thereisonly one Web server, it can be on an independent machine separated from the
PowerServer, or it can be on the same machine where PowerServer resides. If it ison the
same machine with PowerServer, make sure the PowerServer and the Web server are set
up on different Web sites.

» There are two load balancing algorithms: random and sequence. The following graphic
uses sequence which distributes the user requests to the PowerServer in sequential order.
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Figure5.1: Cluster architecture
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The application server must be of the same type and of the same version. PowerServer
supports the following application server types: .NET 11S, JBoss, WebL ogic, WebSphere, and
JEUS. For more details, refer to the Power Server requirements section in Installation Guide
for .NET.

Step 2: Install PowerServer to each application server by following the installation
instructions in the Power Server installation section in Installation Guide for .NET. In

the Select Components page, make sure you select to install the appropriate edition of
PowerServer, for example, select Power Server for .NET if the application server is .NET/
IS.

5.3 Task 3: Create a PowerServer cluster in AEM

Once you have installed PowerServer to several application servers, you can use the AEM
Cluster tool to create a PowerServer cluster and then configure the load balancing and
failover functionalities for the cluster. The following are the detailed instructions.

Step 1: Log into AEM. Each PowerServer hasa AEM. You only need to log in to one of
them for the cluster, make configurations there, and then synchronize the settings to the other
AEMsin the cluster.

Step 2: In the Server | Resource | Cluster tool, add the PowerServer one by one. It is
important that the first PowerServer you add is the one hosting the AEM you are currently
logged into.

1. Click the Add Power Server button under the Cluster Server List table. The Add New
Power Server page opens.

2. Verify that the PowerServer to be configured is running and provide the required
information (IP address, port, AEM user name, and password). For example:
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» |Paddress: 161.0.0.1

Use the IP address or machine name of the PowerServer when adding a PowerServer.
Do not use "localhost” or "127.0.0.1". The IP address or machine name and port number
must match the settings of HTTP listenersin the application server.

* Port: 80
* AEM User Name: admin
* AEM Password: admin
3. Click the Save and Add button to add the other PowerServer. The program will

automatically test the connection and add the PowerServer if the test is successful.
Adding a PowerServer will succeed only if:

» The PowerServer is new to AEM.
» Theinformation provided is correct.
» The PowerServer isrunning.

» Thefirst PowerServer that you add is the one hosting AEM you are currently logged
into.

The PowerServer listed in the Cluster Server List group will work as a cluster in supporting
the requests from their associated Web server.

Step 3: Configure the load balancing and the fail-over settings by following instructionsin
Section 4.3.3.1, “Cluster” in Power Server Configuration Guide for .NET or PowerServer
Configuration Guide for J2EE.

Step 4: Check the status of PowerServer and verify that all servers are running.
Step 5: Click Save to synchronize AEM settings to the other serversin the cluster.

Once a PowerServer is added to the cluster server list, you can use the AEM which maintains
the list to manage al serversin the cluster. Whenever you change the settings of this AEM
and click Save, the settings will be saved to the other serversin the cluster. Therefore, you do
not need to repeat the configuration in each AEM. However, not all of the AEM settings will
be synchronized, because some settings are not necessary to be the same for all servers.
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Figure5.2: Cluster

Welcome > Server > Resources > Cluster

=

Cluster Server List
The following displays information for all PowerServers in the cluster. Please add the local machine first before you add any other server.
Connecttype: @HTTP  OHTTPS

Actions IP Address Port Status

Add PowerServer

= Load Balancing

Load balancing algorithm: L

= Failover

Enable Session Backup
® Session Level
Request Leve
Enable Heartbeat Backup
Enable Remote Backup
Interval Time seconds
® Mirror Backup
Rotation Backup

Enable Logical Restore with Status Monitor

5.4 Task 4: Configure the Web server for the PowerServer cluster

5.4.1 Task 4.1: Important notes for installing IS

If the Web server isthe |1S server, you should make sure the 1S 6 M anagement
Compatibility feature (including its sub-features) and the HT TP Redir ection feature are
selected and installed, otherwise, the application URL and AEM URL cannot be redirected
successfully.
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Figure5.3: Required I Sfeatures
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5.4.2 Task 4.2: Install the PowerServer Web Component on Web server
Step 1: Set up one or more separate Web site(s) as Web server(s).

If the Web server is on the same machine with PowerServer, make sure the PowerServer
and the Web server are set up on different Web sites that use different port number and root
directory.

For detailed system requirements of the Web server, refer to the (Optional) Web server
requirements section in Installation Guide for .NET.

Step 2: Install Power Server Web Component to the Web root (or document root) of each
Web server. For example, the default Web root for 11Sis C:\inetpub\wwwroot, the default
document root for Apache 2.0 is C:\Program Files\Apache Group\A pache2\htdocs.

For detailed instructions, please follow the installation instructions in Power Server Web
Component installation section in Installation Guide for .NET.
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5.4.3 Task 4.3: Configure the Web server with the Appeon cluster plug-in
5.4.3.1 Type 1: IS Web server
5.4.3.1.1 Method 1: Automatic configuration

Installing and configuring Appeon cluster plug-in
Step 1: Get the Appeon cluster plug-in installation package.

After you install Power Server Web Component, you can find the Appeon Cluster plugin
folder under the WebComponent[ver sion]\appeon\l | SSuppor t\ directory, and this folder
isthe Appeon cluster plug-in installation package, as shown in the following figure. Y ou can
copy thisinstallation package to any Web server associated with the PowerServer cluster.

Figure5.4: Appeon Cluster plugin

o |6 ]
@.\_ i <« Appeon » WebComponent2013 » appeon » DSSupport » Appeon Cluster plugin » v-¢," search Appeon Cluster plugin 2
File Edit View Tools Help
Organize v Include in library Share with » New folder = v i @
4 |, WebComponent2013 “*  Name ’ Date modified Type ze
4 |. appeon
PP APECluster
Apachel 3Support
appeon
Apache20Support
AppeonCloud
Apache22Support
U AppeonCluster
- I5Support

g AppeonCluster.exe
# | Appeon Cluster plugin

APECluster

appeon =

. AppeonCluster
g instance

@ Interop.ActiveDs
®| InteropISOle

AppeonCloud

conf . i
@ Interop.]WshRuntimeLibrary
modules

. # logdnet 44}
weblibrary_ax i
log4net 58

Apple Software Update =

| regiis 1k
Beyond Compare 3 o

@ | silentinstall 3k
Bonjour o

Common Files
DVD Maker
frannla

14 items

Step 2: Double-click AppeonCluster.exe under the Appeon Cluster plugin folder to install
the Appeon cluster plug-in to the Web server.

The Appeon Cluster Plug-in Installation Wizard is displayed.
Step 3: Select Create an Appeon Cluster Plug-in on a new Web site, and click Next.

If you want to install to an existing Web site, select Create an Appeon Cluster Plug-in on
an existing Web site, and click Next.

PowerServer Mobile Tutorials Page 65



Tutorial 5: Configure PowerServer Cluster Appeon® PowerServer® 2020

Figure5.5: Create plugin on aWeb site

«y Appeon Cluster Plug-in Installation Wizard " Iﬁ

Welcome to Appeon Cluster Plug-in Installation Wizard

Select an option to continue.

I Create an Appeon Cluster Plug-in on an existing Web site

Select this option to create an Appeon Cluster Plug-in on an existing Web site,

@ Create an Appeon Cluster Plug-in on a new Web site

Select this option to create a new Web site and an Appeon Cluster Plug-in.

~1 Remove an Appeon Cluster Plug-in

Select this option to remove the Appeon Cluster Plug4n from an existing Web site.

Mext= ] [ Cancel

Step 4: To create the Appeon cluster plug-in on a new Web site, configure Description, Port
and Home Directory, then click Next.

The new Web site will be created.
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Figure5.6: Configurethe Web site

#4/ Appeon Cluster Plug-in Installation Wizard ﬁ

Create an Appeon Cluster Plug-in on a new Web site
Enter the information below to create the new Web site and the new Appeon Cluster Plug-in.

Mew Web Site

Description:

TCP Port: -

Home Directory:

Existing Web Site

(] sites
----- % Default Web Site[TCP Port=80;Home Directory=C:\inetpubwwwroat]

Test[TCP Port=80;Home Directory=C:Program Files\Inetpubwwwroot]

<Back ] [ Mext= ] [ Cancel

Step 5: Select to install a 32-bit or 64-bit Appeon cluster plug-in, and click Next. The
program will detect if the server is on 32-bit OS or 64-bit OS and disable the inappropriate

option.

32-bit plug-in works with 32-bit server and 64-bit server, and 64-bit plug-in works with 64-
bit server only.
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Figure5.7: Select run mode

-

23]

«4/ Appeon Cluster Plug-in Installation Wizard

Create an Appeon Cluster Plug-in on a new Web site

Select Appeon Cluster Plug-in run mode.

@ Create a new Appeon Cluster Plug-in (32-bit)

The Appeon Cluster Plug-in will run as a 32-bit program.

The Appeon Cluster Plug-in will run as a 64-bit program.

<Back ] [ Mext= ] [ Cancel

Step 6: Specify the Windows administrator user name and password, and click Next. Make
sure to input the correct user name and password, otherwise you may not be able to access the

Appeon Cluster Manager in the Web browser.
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Figure 5.8: Windows administrator username and passwor d

#4/ Appeon Cluster Plug-in Installation Wizard Iﬁ

specify the Windows administrator user name and password

Enter the username and password of an administrator group member for the 1IS application poal.

The user name and password is required by Appeon Cluster Plug-n to support the cluster environment. | must be
an administrator user name and password of the Windows operating system login account.

|zemame:

Password:

Confirm Password:

<Back ] [ Mext= ] [ Cancel

Step 7: When the plug-in is created successfully, click Finish to exit the Appeon Cluster
Plug-in Installation Wizard.
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Figure5.9: Createtheplug-in

«4/ Appeon Cluster Plug-in Installation Wizard Iﬁ

Create an Appeon Server on a new Web site

Create the Web site "AppeonCluster™ and Appean Cluster Plug-in,

Created the Appeon Cluster Plug-in on the Web site AppeonCluster successfully.

Step 8: Restart 11S to make the new settings effective.

Configuring redirections to PowerServer

After successfully installing and configuring the Appeon cluster plug-in, you can find
AppeonCloud Web console (though it is named "Cloud", it aso applies to non-cloud
platform) under the specified 11S Web site, as shown in the figure below. Y ou can configure
here to which PowerServer(s) and in what order the user requests should be redirected.
Detailed instructions are provided below.

Another important advantage that the cluster providesisfailover. To enable the failover
functionality, you will need to go to the AEM, add PowerServer to the cluster and configure
the failover settings there. For details, refer to Section 4.3.3.1, “ Cluster” in Power Server
Configuration Guide for .NET or PowerServer Configuration Guide for J2EE.

The Appeon cluster currently supports three kinds of platformsincluding L ocal (non-cloud
platform), Amazon Web Services and Windows Azure. The AppeonCloud console will
display different settings according to the specific platform.
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Figure5.10: 11S Manager
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Step 1: Run the AppeonCloud console (browse the console in the right Actions pane in the
[1S manager). The Appeon Cluster Manager displays.

Step 2: Input the user name and password (both "admin") to log into the Appeon Cluster

Manager.

Step 3: Click Cluster Settings. The following settings will be display for the non-cloud

platform.

Add the PowerServer to the list one by one. The Web server will redirect the user requests to

the PowerServer in the list.

» Specify the host name (or | P address) and port number of PowerServer.

* Click Save. PowerServer will be added to the cluster.
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Figure5.11: Local cluster settings

Appeon Cluster Manager > Local Cluster Setting

B Local Cluster Setting

Sets cluster type that is used to store cluster information.

Haost:

Port: a0
Save
Actions Host Port
Delete ocalhost 80
Delete 192.0.2.113 80

Step 4: Configure the other settings of the cluster if necessary, such as load balancing
algorithm, timeout, and interval.

Figure5.12: Cluster settings

Cluster Information Setting

Configures information (such as load balance, timeout, etc.) that is used for Appeon Cluster.

Load Balancing Setting: Random @ Sequence
Timeout Setting: 120
Interval Setting: 5

Table5.1: Morecluster settings

Settings Description

Load Balancing | Specify the load balancing algorithm which determined how requests
will be distributed among the serversin the cluster. Random indicates
that the plug-in distributes requests across PowerServer in random order,
regardless of the status of PowerServer; Sequence indicates that the plug-
in distributes requests to PowerServer in an allocated order.

Timeout Specify the timeout for distributing a request, and the default value is 30
seconds.

Interval Specify the interval (in seconds) for the plug-in to refresh the
PowerServer list.

5.4.3.1.2 Method 2: Manual configuration

Configuring IS 7.x with .NET server

Choose an existing Web site, or create anew site. The Default Web Site will be used as
examplesin the following guide.

1. Installing PowerServer Web component to the Web root of the 1S server.

Make sure you have installed PowerServer Web Component to the Web root of the 1S
server. To verify it, go to the 11S Web root (by default C:\inetpub\wwwroot) and check
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if thereisan appeon folder which at least contains the | | SSupport and weblibrary ax
sub-folders. If any folder is missing, go to the default installation directory of PowerServer
Web Component (C:\Program Files\A ppeon\WebComponent[version]) and manually copy
the entire appeon folder to the I1S Web root.

2. Creating avirtual directory.

Step 1: Open Control Panel | Administrative Tools | Internet Information Service
(11S) Manager.

Step 2: Right click the Default Web Site and select Add Virtual Directory.
Step 3: Input the alias name, for example, "ApbCluster”.

Step 4: Choose alocal path in the Physical path box; for example, "C:\inetpub\wwwr oot
\ApbCluster".

Step 5: Click OK.

Figure5.13: Add virtual directory

Add Virtual Directory B[]

Site name:  Default Web Site
Path: i

Alias:
ApbCluster

Examnple: images

Physical path:
Chinetpubhwwwroot\ApbCluster E]

Pass-through authentication

Connect as... | | Test Settings... |

| O | | Cancel

Step 6: Right click the ApbCluster virtual directory and select Edit Permissions.
Step 7: Choose the Security tab, and then click the Edit button.
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Figure5.14: ApbCluster properties

i

- ApbCluster Properties

| General | Sharing | Security | Previous Versions | Custumize|

[l

Object name:  Chinetpubtwwwroot ' ApbCluster

Group or user names:

f{l‘_ Everyone -
H2 CREATOR OWNER [
2, SYSTEM

ql A Aminictratare (H L RS LY Admimictratore)
4 | i | »

To change permissions, click Edit.

Pemissions for Everyone Allow Dery

L3

Full control

Modify

Read & execute
List folder conterts
Read

Write

m

-

LAENNAS

For special pemmissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

[ OK H Cancel ] Apply

-

Step 8: Select 11S_IUSRS, for example, 11S_TUSRS (HUANGXUXIA\IIS _TUSRS)from
the Group or user nameslist, and then select the Allow check box for M odify and Write
in the Permissionsfor 11S ITUSRSIist.
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Figure5.15: ApbCluster permissions

. Permissions for ApbCluster @

Security

Object name:  Chinetpubwwwroot ' ApbCluster

Group or user names:

B2 SYSTEM -
ii_,;’-‘-dministlatnrs [HUANGXLX] A Administrators)
“-_&?_, Users (HUAMGXLEKIA N sers)

1S _IUSRS (HUANGXUXIANIS_IUSRS)

52 Trustedinstaller

m

1

4 | 10 F
[ Add ] [ Bemove ]
Pemissiong for [15_ILUSRS Allow Dery

Modify | I |-
Read & execute [
List folder contents ] E
Read .
Write |:| e

L eam about access contral and permissions

[ OK H Cancel ] Bpphy

Step 9: Click OK to go back to the 1S window.

3. Copying the Appeon plug-in (ApbCluster.dll or ApbCluster 64.dll).

Copy the ApbCluster.dll (for 32-bit OS) or ApbCluster64.dll (for 64-bit OS) plug-in
from appeon\l | SSupport\modules to the newly created virtual directory (C:\inetpub
\wwwr oot\ApbCluster in this guide).

In the 64-bit OS, you can either use ApbCluster.dll or ApbCluster64.dll. If you use
ApbCluster.dll, you will need to set the Enable 32-Bit Applicationsto True for the
application pool used by the current Web site. If you use ApbCluster 64.dll, then set this
option to False.

4. Creating the Appeon cluster configuration file (cluster-config.xml).

Create the cluster -config.xml file in the newly created virtual directory (C:\inetpub
\wwwr oot\ApbCluster in this guide). The cluster-config.xml file acts as the redirector
configuration file which helps the Web server redirect requests to the PowerServer
according to the I P addresses/ports of PowerServer, and the load balancing algorithm that
it stores.

<?xm version="1.0" encodi ng="UTF-8" ?>
<cluster-config | ocal ="true" |og="debug" ti meout="30" polling="5"
arithneti c="sequence" >
<ext enti on>/ ApbCl ust er/ ApbCl uster. dl | </ extenti on>
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<filters>
<filter>/ AEMK/filter>
<filter>/servliet</filter>
<filter>/reportfile</filter>
<filter>/imagefile</filter>
<filter>/dwfile</filter>
<filter>/aj sdown</filter>

</[filters>

<app- server s>
<app- server host="192.0.0.168" port="88" />
<app- server host="192.0. 3. 131" port="80" />
<app- server host="192.0. 3. 145" port="80" />

</ app- server s>

</cl uster-config>

Notes:

* local specifies whether to read the configurations on the local server or the cloud server.
For the cloud server, set L ocal to False.

* log specifiesthe level of information to be recorded in the log file. It can be set to the
following level: debug, info, warning, error, or off.

* timeout specifies the number of seconds the Web server waits between sending an
HTTP request to PowerServer and receiving information from it. The HTTP connection
timeout valueis 2 times of this value.

* polling indicates the number of seconds when the configurations will be read again.

» arithmetic="random" indicates that the random algorithm is used to pick a
PowerServer; arithmetic="sequence" indicates that the round-robin algorithm is used.

» extention specifies the location of the virtual directory which contains ApbCluster.dll
(or ApbCluster64.dll), that is /virtual-directory-alias-name/ApbCluster.dil (/
ApbCluster/ApbCluster.dll in this guide).

« filter specifiesthe type of pagesto redirect.

* host indicates the I P address (recommended) or machine name of the PowerServer in
the cluster.

 port indicates the port number of the PowerServer in the cluster.

5. Installing the Appeon plug-in as ISAPI Filters.

Step 1. Open Control Panel | Administrative Tools | Internet Information Services
(11S) Manager.

Step 2: Select Default Web Site and then double-click | SAPI Filterson the right side.
Step 3: Right-click the blank area on the ISAPI Filters page, and click Add.

Step 4: Input ApbCluster in the Filter name box and specify ApbCluster.dll (or
ApbCluster64.dll) asthe ISAPI filter in the Executable box (C:\inetpub\wwwr oot
\ApbCluster\ApbCluster.dll in thisguide). Click OK.
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Figure5.16: Add ISAPI filter

Add ISAPI Filter =
Eilter name:
ApbCluster
Executable:;
Chinetpubiwwwroot\ ApbCluster ApbCluster.dll E]
| OK | | Cancel |

6. Copying the redirector configuration file (ApbCluster .cfg).

Copy the ApbCluster .cfg redirector configuration file from appeon\I | SSuppor t\conf\
to the virtual directory (C:\inetpub\wwwr oot\ApbCluster in this guide) and edit the file
when necessary.

Ext ensi on_URI =/ Apbd ust er/ Apbdl ust er. dl |
Mat chExpr essi on=/ AEM

Mat chExpr essi on=/ ser vl et

Mat chExpr essi on=/reportfile

Mat chExpr essi on=/i magefil e

Mat chExpr essi on=/ dwfi |l e

Mat chExpr essi on=/ aj sdown

Log=0On

Notes:
» The Extension_URI command points to the virtual directory where ApbCluster.dll

(or ApbCluster64.dll) resides, that is /virtual-directory-alias-name/ApbCluster.dil (/
ApbCluster/ApbCluster.dll in this guide).

» The MatchExpression command specifies the pages to be redirected.

» The L og command specifies whether logging is enabled. On indicates logging is
enabled; Off indicateslogging is disabled.

» The commands and parameters are case insensitive.

7. Setting ISAPI and CGI Restrictions.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(11S) Manager.

Step 2: Select the local machine (the top node), and then double-click | SAPI and CGl
Restrictions on the right side.
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Step 3: Right-click the blank area of the ISAPI and CGI Restrictions page and click
Add.

Step 4: Specify the local path of ApbCluster.dll (or ApbCluster64.dll) in the | SAPI or
CGl path box and input the descriptive text in the Description box, and then select Allow
extension path to execute.

Step 5: Click OK.

Figure5.17: Add ISAPI or CGI

Add ISAPI or CGI Restriction [~ B[]
ISAPI or CGI path:
Chinetpubiwwwroot\ApbClusterApb Cluster.dll
Description:

ApbCluster for Default Web Site

| Allow extension path to execute

Ok l | Cancel

8. Enabling ISAPI-dII.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(11'S) Manager.

Step 2: Expand Default Web Site, select ApbCluster, and then double-click Handler
M appings on the right side.

Step 3: Right-click | SAPI-dII, and select Edit Feature Permissions.
Step 4: Select Read, Script, Execute, and click OK.

Figure5.18: Edit feature permissions

Edit Feature Permissions @
Perrnissions:
| Read
| Script
| Execute
0K l | Cancel
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9. Adding MIME type for loading the pages without extension names or pages without
MIME types defined.

Step 1. Select Default Web Site and then double-click MIME Types on the right of the
page.

Step 2: Right-click the blank area of the MIME Types page, and click Add.
Step 3: Specify the following settings:

* Extension: *
* MIME Type: application/octet-stream

Step 4: Click OK.

Figure5.19: Add MIME type

Add MIME Type R

File name extension:

E

MIME type:

application/octet-stream

Ok l | Cancel

10.Restarting 11S.
Restart 11S to make the new settings effective.

Configuring IS 7.x with J2EE server

J2EE serversrefer to the Java application servers, such as WebL ogic, WebSphere, JBoss,
JEUS etc. The configuration is the same for the J2EE application servers that PowerServer
supports.

Choose an existing Web site, or create anew site. The Default Web Site will be used as
examplesin the following guide.

1. Installing PowerServer Web component to the Web root of the 1S server.

Make sure you have installed PowerServer Web Component to the Web root of the 1S
server. To verify it, go to the 11S Web root (by default C:\inetpub\wwwroot) and check

if thereisan appeon folder which contains the 11 SSupport and weblibrary ax sub-
folders. If any folder is missing, go to the default installation directory of PowerServer
Web Component (C:\Program Files\A ppeon\WebComponent[version]) and manually copy
the entire appeon folder to the I1S Web root.

2. Creating avirtual directory.
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Step 1: Open Control Panel | Administrative Tools | Internet I nformation Service
(11'S) Manager.

Step 2: Right click Default Web Site and select Add Virtual Directory.
Step 3: Input the alias name, for example, "ApbCluster”.

Step 4: Choose alocal path in the Physical path box; for example, "C:\inetpub\wwwr oot
\ApbCluster".

Step 5: Click OK.

Figure5.20: Add virtual directory

Add Virtual Directory ==

Site name:  Default Web Site
Path: !

Alias:

ApbCluster

Exarmnple: images

Physical path:

Chinetpubhwwwroot\ApbCluster E]

Pass-through authentication

Connect as... | | Test Settings... |

| Ok | | Cancel

Step 6: Right click the ApbCluster virtual directory and select Edit Permissions.
Step 7: Choose the Security tab page and then click the Edit button.
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Figure 5.21: appeoncluster properties

i

- ApbCluster Properties

| General | Sharing | Security | Previous Versions | Custumize|

[l

Object name:  Chinetpubtwwwroot ' ApbCluster

Group or user names:

f{l‘_ Everyone -
H2 CREATOR OWNER [
2, SYSTEM

ql A Aminictratare (H L RS LY Admimictratore)
4 | i | »

To change permissions, click Edit.

Pemissions for Everyone Allow Dery

L3

Full control

Modify

Read & execute
List folder conterts
Read

Write

m

-

LAENNAS

For special pemmissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

[ OK H Cancel ] Apply

-

Step 8: Select 11S_IUSRS, for example, 11S_TUSRS (HUANGXUXIA\IIS _TUSRS)from
the Group or user nameslist, and then select the Allow check box for M odify and Write
in the Permissionsfor 11S ITUSRSIist.
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Figure 5.22: appeoncluster properties

. Permissions for ApbCluster @

Security

Object name:  Chinetpubwwwroot ' ApbCluster

Group or user names:

B2 SYSTEM -
ii_,;’-‘-dministlatnrs [HUANGXLX] A Administrators)
“-_&?_, Users (HUAMGXLEKIA N sers)

1S _IUSRS (HUANGXUXIANIS_IUSRS)

52 Trustedinstaller

m

1

4 | 10 F
[ Add ] [ Bemove ]
Pemissiong for [15_ILUSRS Allow Dery

Modify | I |-
Read & execute [
List folder contents ] E
Read .
Write |:| e

L eam about access contral and permissions

[ OK H Cancel ] Bpphy

Step 9: Click OK to go back to the 1S window.

3. Copying the Appeon plug-in (ApbCluster.dll or ApbCluster 64.dll).

Copy the ApbCluster.dll (for 32-bit OS) or ApbCluster64.dll (for 64-bit OS) plug-in
from appeon\l | SSupport\modules to the newly created virtual directory (C:\inetpub
\wwwr oot\ApbCluster in this guide).

In the 64-bit OS, you can either use ApbCluster.dll or ApbCluster64.dll. If you use
ApbCluster.dll, you will need to set the Enable 32-Bit Applicationsto True for the
application pool used by the current Web site. If you use ApbCluster 64.dll, then set this
option to False.

4. Creating the Appeon cluster configuration file (cluster-config.xml).

Create the cluster -config.xml file in the newly created virtual directory (C:\inetpub
\wwwr oot\ApbCluster in this guide). The cluster-config.xml file acts as the redirector
configuration file which helps the Web server redirect requests to the PowerServer
according to the I P addresses/ports of PowerServer, and the load balancing algorithm that
it stores.

<?xm version="1.0" encodi ng="UTF-8" ?>
<cluster-config | ocal ="true" |og="debug" ti meout="30" polling="5"
arithneti c="sequence" >
<ext enti on>/ ApbCl ust er/ ApbCl uster. dl | </ extenti on>
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<filters>
<filter>/ AEMK/filter>
<filter>/servliet</filter>
<filter>/reportfile</filter>
<filter>/imagefile</filter>
<filter>/dwfile</filter>
<filter>/aj sdown</filter>

</[filters>

<app- server s>
<app- server host="192.0.0.168" port="88" />
<app- server host="192.0. 3. 131" port="80" />
<app- server host="192.0. 3. 145" port="80" />

</ app- server s>

</cl uster-config>

Notes:

* local specifies whether to read the configurations on the local server or the cloud server.
For the cloud server, set L ocal to False.

* log specifiesthe level of information to be recorded in the log file. It can be set to the
following level: debug, info, warning, error, or off.

* timeout specifies the number of seconds the Web server waits between sending an
HTTP request to PowerServer and receiving information from it. The HTTP connection
timeout valueis 2 times of this value.

* polling indicates the number of seconds when the configurations will be read again.

» arithmetic="random" indicates that the random algorithm is used to pick a
PowerServer; arithmetic="sequence" indicates that the round-robin algorithm is used.

» extention specifies the location of the virtual directory which contains ApbCluster.dll
(or ApbCluster64.dll), that is /virtual-directory-alias-name/ApbCluster.dil (/
ApbCluster/ApbCluster.dll in this guide).

« filter specifiesthe type of pagesto redirect.
* host indicates the I P address (recommended) or machine name of the PowerServer.
* port indicates the port number of the PowerServer.

5. Installing the Appeon plug-in as ISAPI Filters.

Step 1. Open Control Panel | Administrative Tools | Internet Information Service
(11S) Manager.

Step 2: Select Default Web Site and then double-click | SAPI Filterson the right side.
Step 3: Right-click the blank area on the ISAPI Filters page, and click Add.

Step 4: Input ApbCluster in the Filter name box and specify ApbCluster.dll (or
ApbCluster64.dll) asthe ISAPI filter in the Executable box ( C:\inetpub\wwwr oot
\ApbCluster\ApbCluster.dll in thisguide). Click OK.
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Figure5.23: Add ISAPI filter

Add ISAPI Filter =
Eilter name:
ApbCluster
Executable:;
Chinetpubiwwwroot\ ApbCluster ApbCluster.dll E]
| OK | | Cancel |

6. Copying the redirector configuration file (ApbCluster .cfg).

Copy the ApbCluster .cfg redirector configuration file from appeon\I | SSuppor t\conf\
to the virtual directory (C:\inetpub\wwwr oot\ApbCluster in this guide) and edit the file
when necessary.

Ext ensi on_URI =/ Apbd ust er/ Apbdl ust er. dl |
Mat chExpr essi on=/ AEM

Mat chExpr essi on=/ ser vl et

Mat chExpr essi on=/reportfile

Mat chExpr essi on=/i magefil e

Mat chExpr essi on=/ dwfi |l e

Mat chExpr essi on=/ aj sdown

Log=0On

Notes:
» The Extension_URI command specifies the location of the virtual directory which

contains ApbCluster.dll (or ApbCluster 64.dll), that is /virtual-directory-alias-name/
ApbCluster.dil (/ApbCluster/ApbCluster.dll in this guide).

» The MatchExpression commands specify the type of pages to redirect.

» The L og command specifies whether to enable logging. On indicates logging is
enabled; Off indicateslogging is disabled.

» The commands and parameters are case insensitive.

7. Setting ISAPI and CGI Restrictions.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(11S) Manager.

Step 2: Select the local machine (the top node), and then double-click | SAPI and CGl
Restrictions on the right side.
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Step 3: Right-click the blank area of the ISAPI and CGI Restrictions page and click
Add.

Step 4: Specify the local path of ApbCluster.dll (or ApbCluster64.dll) in the | SAPI or
CGl path box and input the descriptive text in the Description box, and then select Allow
extension path to execute.

Step 5: Click OK.

Figure5.24: Add ISAPI or CGI

Add ISAPI or CGI Restriction [~ B[]
ISAPI or CGI path:
Chinetpubiwwwroot\ApbClusterApb Cluster.dll
Description:

ApbCluster for Default Web Site

| Allow extension path to execute

Ok l | Cancel

8. Enabling ISAPI-dII.

Step 1: Open Control Panel | Administrative Tools | Internet Information Services
(11'S) Manager.

Step 2: Expand Default Web Site, select ApbCluster, and then double-click Handler
M appings on the right side.

Step 3: Right-click | SAPI-dII, and select Edit Feature Permissions.
Step 4: Select Read, Script, Execute, and click OK.

Figure 5.25: Edit feature permissions

Edit Feature Permissions @
Perrnissions:
| Read
| Script
| Execute
0K l | Cancel

9. Adding MIME type for loading the pages without extension names or pages without
MIME types defined
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Step 1: Select Default Web Site and then double-click MIME Types on the right of the
page.
Step 2: Right-click the blank area of the MIME Types page, and click Add.

Step 3: Specify the following settings:
» Extension: *
* MIME Type: application/octet-stream

Step 4: Click OK.

Figure5.26: Add MIME type

Add MIME Type =

File name extension:

W

MIME type:

application/octet-stream

Ok l | Cancel

10.Restarting 11S.
Restart 11S to make the new settings effective.

5.4.3.2 Type 2: Apache Web server
5.4.3.2.1 Manual configuration

Configuring Apache 2.0/22 with J2EE servers

J2EE serversrefer to Java application servers, such as WebL ogic, WebSphere, JBoss,
JEUS etc. The configuration is the same for the J2EE application servers that PowerServer
supports.

1. Installing PowerServer Web component to the document root of the Apache Web server.

Make sure you have installed PowerServer Web Component to the document root of the
Apache Web server. To verify it, go to the Apache document root (by default %APACHE
%\htdocs) and check if there is an appeon folder which contains the Apache20Support,
Apache22Support and weblibrary_ax sub-folders. If any folder is missing, go to the
default installation directory of PowerServer Web Component (C:\Program Files\Appeon
\WebComponent[version]) and manually copy the entire appeon folder to the Apache
document root.

2. Copying Appeon plug-in.
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Copy the mod_appeon2.so or mod_appeon22.so plug-in file from %APA CHEY\htdocs
\appeon\A pache2xSupport\modules to the %A PACHE%\modul es fol der.

3. Copying Appeon Cluster configuration file.

Copy the cluster-config.xml file from the %appeon%\repository\<instancename>\config
folder to the %APACHE%Y\conf folder, where %appeon% is the installation directory of
PowerServer, and <instancename> refers to the name of the PowerServer instance.

Note: The cluster-config.xml file acts as the redirector configuration file which helps

the Web server redirect requests to PowerServer according to the IP addresses/ports

of PowerServer, and the load balancing algorithm that it stores. This file should not be
modified manually asit will be automatically updated when you change the settingsin the
Cluster tool of AEM. Each time after you change the settings, be sure to copy thisfile and
replace the old file in the %A PACHE%Y\conf folder and restart Apache.

4. Modifying httpd.conf.

If the application server (such as WebL ogic, WebSphere, JBoss, or JEUS) is running on
Windows, add the following statements into the httpd.conf file under the %APACHE%Y
\conf folder (take mod_appeon2.so as an example):

LoadMobdul e appeon_nobdul e nodul es\ nod_appeon2. so
<| f Modul e nod_appeon. c>

Mat chExpr essi on / AEM

Mat chExpr essi on /servl et

Mat chExpression /reportfile

Mat chExpressi on /i magefile

Mat chExpression /dwfil e

Vat chExpr essi on / aj sdown

</| f Modul e>

If the application server isrunning on UNIX/LINUX, add the following statements into
the httpd.conf file under the %A PACHE%\conf folder (take mod_appeon2.so as an
example):

LoadModul e appeon_nodul e nodul es/ nod_appeon2. so

<I| f Modul e nbd_appeon. c>

Mat chExpr essi on / AEM

Mat chExpr essi on /servl et

Mat chExpression /reportfile

Mat chExpressi on /i magefil e

Mat chExpression /dwfil e

Mat chExpr essi on / aj sdown
</'| f Modul e>

5. Restarting Apache.
Restart Apache for the new settings to take effect.

Configuring Apache 1.3 with J2EE servers

J2EE serversrefer to the Java application servers, such as WebL ogic, WebSphere, JBoss,
JEUS etc. The configuration is the same for the J2EE application servers that PowerServer
supports.

1. Installing PowerServer Web component to the document root of the Apache Web server.
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Make sure you have installed PowerServer Web Component to the document root of the
Apache Web server. To verify it, go to the Apache document root (by default %APACHE
%\htdocs) and check if there is an appeon folder which contains the Apache20Support,
Apache22Support and weblibrary_ax sub-folders. If any folder is missing, go to the
default installation directory of PowerServer Web Component (C:\Program Files\Appeon
\WebComponent[version]) and manually copy the entire appeon folder to the Apache
document root.

2. Copying Appeon plug-in.

Copy the mod_appeon.so plug-in file from %A PACHE%\htdocs\appeon
\A pachel3Support\modules to the %A PACHEY\modules folder.

3. Copying Appeon Cluster configuration file.

Copy the cluster-config.xml file from the %appeon%\repository\<instancename>\config
folder to the %A PACHEY\conf folder, where %appeon% is the installation directory of
PowerServer, and <instancename> refers to the name of a server instance.

Note: The cluster-config.xml file acts as the redirector configuration file which helps

the Web server redirect requests to PowerServer according to the IP addresses/ports

of PowerServer, and the load balancing algorithm that it stores. This file should not be
modified manually asit will be automatically updated when you change the settingsin the
Cluster tool of AEM. Each time after you change the settings, be sure to copy thisfile and
replace the old file in the %A PACHE%Y\conf folder and restart Apache.

4. Modifying httpd.conf.
Add the following statements into the httpd.conf file under the %A PACHEYb\conf folder:

LoadModul e appeon_nodul e nodul es\ nod_appeon. so
<I| f Modul e nod_appeon. c>

Mat chExpr essi on / AEM

Mat chExpr essi on /servl et

Mat chExpression /reportfile

Mat chExpr essi on /i nmagefile

Mat chExpr ession /dwfil e

Mat chExpr essi on / aj sdown

</| f Modul e>

5. Restarting Apache.
Restart Apache for the new settings to take effect.

5.4.4 Special instructions for Auto Scaling in Amazon Web Service

Auto scaling in the Amazon Web Service (not Windows Azure) cloud server is supported
by PowerServer for .NET (not J2EE). Make sure the cloud server is activated against the
Appeon cloud license; for instructions on activating the cloud server, refer to Section 4.3.4,
“Product Activation” in Power Server Configuration Guide for .NET. In this section,
instructions are provided for supporting auto scaling in the Amazon Web Service cloud
server.
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5.4.4.1 Modifying the Appeon cluster config file

After installing the Appeon cluster plug-in, modify the Appeon cluster config file under the
installation folder: AppeonCluster\A ppeonCloud\Config\ClusterM anager.config.

Specify the following parameters in the ClusterManager.config file.

<AWSSt or age accessKey="" secret Key="" node="" defaul tPort="" keywordPrefix=""/>

 accessKey (access key D), secretK ey (access secret key), and keywordPrefix (keyword
prefix), by following instructions in the section called “AWS server instance settings’ in
Power Server Configuration Guide for .NET.

* defaultPort: port number of PowerServer, by default it is 80.
* mode: the switch for supporting auto scaling.

 1: supports auto scaling by automatically detecting PowerServers and updating the
PowerServer list in the cluster.

* 0: does not support auto scaling (so the developer needs to manually update the
PowerServer list in the cluster).

5.4.4.2 Modifying the PowerServer config file

Under the PowerServer installation folder, modify the PowerServer config file: appeon\AEM
\config\cluster-config.config.

Specify the following parameters under the cluster-config node in the cluster-config.config
file, by following the aforementioned instructions.

node="" defaul tport=""

5.5 Task 5: Deploy or Install the application to the PowerServer
cluster and Web server(s)

To install a PowerServer application to the PowerServer cluster and Web server(s), you can
either deploy the application viathe Power Server Application Deployment Wizard (see
Chapter 5, Deploying PowerBuilder Applicationsin Power Server Toolkit User Guide, or run
the deployment project generated by using the Power Server Application Package Wizard
(see Section 9.2, “Packaging a stand-alone mobile project” in Power Server Toolkit User
Guide. This section will talk about how to install an application by running the deployment
project generated via the Power Server Application Package Wizard.

5.5.1 Points to note before installation

Be aware of the following points before installing a PowerServer application:

» The Setup program of the Web application or the mobile application runs on the Windows
platform only. To install applications to servers running on Unix\Linux, you must run the
Setup program on the Windows platform and then install the application to remote servers
running on Unix\Linux.
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» Thetarget Web servers must have the PowerServer Web Component correctly installed.

5.5.2 Installing an application

Y ou can copy the generated package to any computer running Windows and install the
application to any number of PowerServer and Web servers. Installing an application using
the generated package is the same as deploying an application using the Power Ser ver
Application Deployment Wizard.

Step 1: Start the target PowerServer(s) and Web server(s) where you want to install the
application.

Step 2: Run the Setup.exe file in the generated package.
The PowerServer Application Deployment Wizard is displayed. Click Next to proceed.

Figure5.27: Welcome page

E@.&ppeun Spplication Deployment (]

Welcome to the Appeon Deployment Wizard!

Thiz wizard will install the packaged Appeon application on
YOUr cornpuker.

To continue, click Mest. Tao esit the wizard, click Cancel,

< Back, Mest> | I Cancel I

Step 3: Select the deploy-config file (config.xml) to ease your configuration of the
installation wizard. The installation wizard will use the settings in the config.xml file.

If you do not want to use the deploy-config file, ssimply skip this option and click Next to
configure the settings step by step.
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Figure 5.28: Select the configuration file

ﬁ.&ppeun Spplication Deployment (5]

Select an Existing Deploy-config File

Fleaze select an exizting deploy-config file for quick configuratio

The wizard automatically loads the configuration file for the current package and uses the settings
it thiz file as the default gettings for the subsequent steps. You can modify the settings in thiz file or
gelect another configuration file.

Maote: 'ou can clear the configuration file path in the Destination File bow and click Mext to
configure the settings manually.

Destination File

MAppecntiy ebfppPackagebappeon code examples installsinioonfio.sm Browse...

[ < Back ][ Hest » ] [ Cancel ]

Step 4: Input the Application Profile Name and the Application URL for the application and
click Next.

The Application Profile Name is used as the application name to identify an application. If
you want to install multiple instances of the same application on the same server, you can
run the setup package repeatedly and specify different Application Profile Name here. For
example, input appeon_code _examples_test as the Application Profile Namein the first
installation, and input appeon_code_examples_production as the Application Profile Name
in the second installation. The Application Profile Name will be used as the application
name to distinguish the multiple application instances on the same server, so they can berun
independently from each other.
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Figure 5.29: Specify Application Profile Name and Application URL

ﬁ.&ppeun Spplication Deployment ==

Specify Deployment Settings

Fleaze specify the profile name and the URL for the applicatio

Fleasze specify the URL for the application.

Application Profile Mame: s EREEITEES

Application LRL

http:/fweb server:port/ appeon_code_exarnples

l < Back |[ Hest » ]l Cancel |

Step 5: Configure and select profiles for the PowerServer(s) and the Web server(s) where the
application will be installed.

To install the application to a PowerServer cluster, please create a PowerServer profile for
each PowerServer in the cluster. For detailed instructions on how to create the PowerServer
profile and Web server profile, refer to Section 3.2.3, “Managing server profiles’ in

Power Server Toolkit User Guide.
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Figure 5.30: Specify server settings

i Sppeon Application Deployment

Server Settings

Fleaze select the Appeon Server and the ‘Web Server.

Appeon Servers

Selected  Profile Name Semver Type Edi...
| F [ 132.0.1.56 EAServer

Add..
4| 1 | » Delete

Wb Servers
Selected  Prafile Mame Edit...
[ 192.0.1.56_EAServer
Delete

[ < Back ]E Mest » ] [ Cancel ]

Step 6: Select whether to install AEM settings and data sources for the current application
and click Next.

Figure 5.31: Deploy AEM settings

ﬂ Appean Application Deployment

Deploy AEM Settings
Fleasze zpecify how to deploy the AEM zettings.

Pleaze select whether to deploy the AEM zettings and data source settings to the specified
Appeon Server.

[] Data Source

[f a data source with the zame name already exists in the Appeon Server, then

i@ Owverwrite it Do nat avvenarite it

< Back ]E Mest » ] [ Cancel
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Step 7: Specify the destination folder for the undeployment tool and the log file and click

Next.

Figure 5.32: Specify location for the Power Server Undeployment Tool

ﬁ.&ppeun Spplication Deployment (=5

Install the Appeon Undeployment Tool

Fleaze select the folder where the Appeon Undeployment Tool wi

Pleaze zpecify where the Appeon Undeployment T ool will reside. The deplop-config file and the
deplay lag will alzo be stared in this folder.

Deztination Folder

C:%Program FilezhAppeontl ndeployhappeon cade examples

[ < Back ][ Hest » ] [ Cancel ]

Step 8: Specify the destination file and source file that you want to replace for the
PowerServer application package, and click Next.

Files (also called "destination fil€") under the "wcode" folder of PowerServer application

package can be replaced by files of the same type (also called "sourcefile"), so that the

source file will be installed instead of the destination file. When you click the Add button,
the File Replacement dialog box is opened. To select the destination file, click Browse

to display the Open file dialog which will automatically open the "wcode" folder of

PowerServer application package, so you can conveniently select afile from the "wcode"
folder or from its subfolder. To select the sourcefile, click Browse to navigate to the folder

where the source file is stored.
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Figure 5.33: Specify filesto replace for the application package
rﬁ Appeon Application Deployment uﬂ

Replace Files

Pleaze specify the files that you want to replace for the appl

Mo, Destination File Source File Edi...
Add...
Delete
4 1y 3

| <Back || Net> | | Cancel

Step 9: Wait while the wizard isinstalling files and settings.

Figure 5.34: Deploying the application

ﬂ.&ppeun Application Deployrment
Deploying the Application 1

The deployment wizard iz perfarming the requested operatio

bl

Fleaze wait while the deplopment wizard iz deploying the application. This may take several
! iribes.

Time  Run Information
13193:23  Deploving application name to Appean Server...
131924 Deploying IMI file(z] to Appeon Server...
131924 Deploying D atavwindow SOL to Appeon Server...
181924 Committing changes to Appeon Server...
1813:256  Deploying embedded SOL to Appeon Server...
1819326 Committing changes to Appeon Server...
1819326 Deploving Datawindow Syntas to Appeon Server...

seceeoe | Gh

ey

i | 3
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Step 10: Once the operation is complete, click Finish to exit the installation wizard.

To run the application immediately, select the Run Application Now option and click
Finish. Or you can run the application later from the Windows Start | Programs | Appeon
Web Application | ApplicationName.

To view the log information generated during the installation process, select the View Log
box and then click Finish. Thelog file will be displayed.

Figure 5.35: Deployment complete

Eﬁ.&ppeun Application Deployrment @

Finizhed deploying the Appeon application.

The deployment wizard haz finished inztalling the application and
the related zettings to the cormputer.

[ iRun Application Mow

[] Wiew Log

Click Finish to exit the wizard.

< Back Cancel
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